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How to Print Wiring Diagram Pages

Many of the original Ford wiring manuals were created in a very large format (11x17, 17x24, and 17x36)
making it difficult to print on a standard home printer. Some printers will print only a portion of the entire
page, while others will shrink the page into an unreadable format. However, Adobe Reader has the ability
to print sections (known as Tiles) of the page onto standard 8.5x11 paper. Please use the steps below to
print these wiring diagrams.

You can print a large format document, such as these wiring
diagrams, by splitting the page across multiple sheets of paper (called
"tiling™). The tiling option calculates how many sheets of paper are

+
needed. You can adjust the size of the original to best fit the paper and
specify how much each "tile™ overlaps. You can then piece together
the tiles.

1. Choose File > Print.

2. From the Page Scaling pop-up menu, select one of the following options:
Tile Large Pages Tile only the pages that are Iarger than the paper.

Tile All Pages Tile all the pages in the PDF
file.

=8 uvis IxPes Joae O0% Sages B

Curert e

Note: If the tile options are not in the menu, make 2
sure that the following options are not selected in '
the Advanced Print dialog box: Print As Image or, ——— =S
for Acrobat only, Separations or In-RIP S [
Separations. Also check your version of Reader. | e st [ e g e

Reader 9 does not support tiling. —d

-

3. Set the following options as needed:
Tile Scale Scales the pages by the amount

you specify.
Overlap Determines the amount each tile overlaps adjacent tiles.
Cut Marks Adds guide marks to each page to help you trim the overlap.

Labels Adds the filename and page number on each "tile".

= = Oi— Cut Marks show where to trim pages.
4. Click OK gives you space to adhere
: the pages together without covering
or Print. a portion of the image.

Labels indicate which portion of the
document is represented on a page
A to help you assemble the poster or
banner in the proper order.

@)
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How to Print a Portion of a Wiring Diagram

You can print a portion of a page in a PDF. The
Snapshot Tool lets you select just the area you want
to print. The area can be text, graphics, or both. You
can print the selected area full size or resize it to fit
the paper.

1. Open the PDF in Adobe Reader or Adobe Acrobat.

2. (Acrobat X/Reader X) Choose
Edit > Take A Snapshot.
(Acrobat 9/Reader 9) Choose
Tools > Select & Zoom >
Snapshot Tool.

3. Drag a rectangle around the
area you want to print.

4. Choose File > Print.

5. Make sure that the Selected
Graphic option is selected in the
Print Range area of the Print
dialog box.

St Range
C ai S
.rde:kd vap'x >
Cument page

1

| ¥ 8.5

6. (Optional) To enlarge the

selected text or graphic to fit the
sheet of paper, choose Fit To
Printable Area from the Page

Page Handing "—h’- - -
Copes: L —E—oe— K’ %

Scaling pop-up menu. ruge scarlg [Prpime ea ¥ N |

. . (] Auto Botate Bnd-Centae.—— Sl s et

l\kllote..Etnl(:;lrglngI t?e area reduces e e ros ra

e printed resolution. E" *

P W% | NI
[lerint o fle .

7. Click OK or Print.
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How to Print a Portion of a Wiring Diagram

Print Current View

S B sRm srEREEE . Youcan print just the current zoom-in
e sl T S view of a page in a PDF. The print
et | mmeee e Current View lets you print just the
J I%E“il HEIWJ F=*  current view seen on the screen. The
‘ o iifm P . | area can be text, graphics, or bo_th. You
oy I‘ ‘et | can print the selected area full size or
,;;:1;:_: M | I— —i=  resize it to fit the paper.

1. Open the PDF in Adobe Reader or Adobe Acrobat.
2. Zoom into the portion of the diagram you want to print.

Choose File > Print. - -
Printer. | Xerox Phaser 8560DN PS +| [ Properties | [ advanced | Help &
Make sure the Current Copiess L 1 [E] Print ins grayseale (black and wihite)
View option is selected Pages to Pint e
in the PageS tO Print ..:’::"entpage [DncumsntandMarkups -
H - : o1 ummarize Lomments

area of the Print dialog o [ T
bOX * More Options Scale:125%

’ B ey 8.5 x11 Inches

All pages in range

Note — To select

Reverse pages

Current VieW, you may Page Sizing & Handling (@)
need to CIiCk the “More [ nge || E]DPo;ter l @ Multiple E Booklet
Options” dropdown. o i

() Actual size

") Shrink oversized pages

(© Custom Scale:  [100 %

[] Choose paper source by PDF page size

5. (Optional) To enlarge
the selected text or

[ Print on both sides of paper

graphic to fit the sheet Onentations

1 @ Auto portrait/landscape
of paper, choose Fit To s ; = U =
Printable Area from the B onikcipe Pagel of1 16
Page Scaling pop-up s [ e
menu.

Note: Enlarging the area reduces the printed resolution.

6. Click OK or Print.
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1976 TRUCK WIRING
DIAGRAMS
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F-100-350 Series
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Ford Parts and Service Division
Training and Publications Department

) illustrations contained in this book were in effect at the time the book was approved for printing. Ford Motor Companies, whose
icy is one of continuous improvement, reserves the right to discontinue models at any time, or to change specifications or design,
10ut notice and without incurring obligations.

INDEX

An INDEX is provided behind the divider for each
truck series. The index page contains an al-
phabetically arranged list of systems and compo-
nents and a bulb usage list. The index lists the
location of the components on the drawing. Ex-
a’Tples of the two types of index references are
shown:

A. To locate an electrical part at D-49, find the
location number 49 at the top of the illustra-
tion. Then, find the letter D on the side of the
illustration. Follow the number and the let-
ter until the lines intersect. The part will be
within an ineh or two of the intersection.

B. To locate an electrical part at PG3-D10, turn
to page 3 as indicated in the lower right
corner of the sheet. Then, find the number
10 at the top of the illustration and the letter
D on the side of the illustration. Follow the
number and the letter until the lines inter-
sect. The part will be within aninch or two of
the intersecting lines.

BASIC INFORMATION

Generally, the power supply for all components
on this drawing comes from the top of the page
and over to the battery at the left.

The ground for each component is always toward
#he bottom of the drawing that are explained as
ollows:

e Ground symbols are shown in Figure 1. A
ground wire connected away from the com-
ponent is indentified by a code G1 or G2, etc.
The location of the remote ground is listed in
the GROUND CODES chart and the botton of
the page.

= Lo

Fig. 1 — Ground Symbols

e Wire color code is shown in Figure 2. Wire
color codes (by color) are listed on page-4.

640 (Red-Yellow Hash)

Fig. 2 — Wire Color Code

If a vehicle specific wire color in a connector does
not match the diagram shown, it can usually be
identified by comparing the other colors shown at
the wire connectors. Specific wire color devia-
tions in the manufacturing of a wire harness are
usually for a short duration.

HOW TO USE THE WIRING DIAGRAMS

e Harness number is shown in Figure 3. The 5
or 6 digit number near the wire indicates the
wire harness basic part number.

14290

wris (@) Oy
@ @

Fig. 3 — Harness Number

e Wire connector identification code is shown
in Figure 4. The key for the connector codes is
located at the bottom of the wiring diagram.

NN
vl

Cc22
Fig. 4 — Wire Connector Code

e Male connector symbol isillustrated in Figure
5. The symbol used for the diagram and chart
is shown.

IAGRAM
DIAGR CHART
Fig. 5 — Male Connector Codes

e Female connector symbol is shown in Figure
6.

— O

DIAGRAM CHART
Fig. 6 — Female Connector Codes

e Splice is shown in Figure 7. A splice is a
common point where two wires are joined
together. Location of splice is at bottom of
schematic page.

Fig. 7 — Splices

e Heavy lines for the wires indicate a direct to
battery feed.

e Heavy dashed lines indicate an ignition
switch accessory feed.

Electrical symbols used in the schematics are il-
lustrated and described on the next page.
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ELECTRICAL SYMBOLS

" 8

MISCELLANEOUS COMPONENTS]

COMPONENT SYMBOLS

RELAYS

2 = ATERMINAL CONNECTION g &,OJ
v = A FEMALE TERMINAL E = JUNCTION BLOCKS =VARIOUS SIZE FUSES ! - ARELAY - A SWITCH = A SWITCH
A = AMALE TERMINAL ; - *{;‘3‘3;5;52.:‘,&,?‘,3‘; (USED WITH FUSE PANELS) (SINGLE POLE. SINGLE THROW. (SINGLE POLE. SINGLE THROW. (SINGLE POLE. DOUBLE THROW.
Q 3= DOUBLE TERMINAL = A BATTERY NORMALLY OPEN) NORMALLY OPEN) ONE CONTACT NORMALLY CLOSED.
O = A GRAPHIC FEMALE ROUND TERMINAL. S WiTH BUSS BAR (12voLT ONE CONTACT MOMENTARY)
AND/OR A SWITCH CONTACT. AND/OR =
ASTUD ON A COMPONENT. 4 = MOMENTARY SWITCH CONTACT = A SWITCH
= AN INLINE FUSE & HOLDER = A RELAY o) (SINGLE POLE. SINGLE THROW. = A SWITCH
@ = A GRAPHICS MALE TERMINAL (STD.} \ =DISTRIBUTOR SWITCH CONTACT @ = A SINGLE FILAMENT BUL H (SINGLE POLE. SINGLE THROW. --g NORMALLY OPEN. TEMPERATURE (DOUBLE POLE. DOUBLE THROW.
(W/O GROUND) NORMALLY CLOSED) Q SENSITIVE) Ty NORMALLY CLOSED. GANGED.
@ = ASPLICE. AND/OR A CHASSIS = BREAK BEFORE MAKE SWITCH WIPER TEMPERATURE SENSITIVE)
CONNECTION. AND/OR A GRAPHICS (THREE OR MORE POSITIONS) = A CIRCUIT BREAKER MAJOR FILAMENT
EMPTY CONNECTOR CAVITY FOR @ (FUSE PANEL MOUNTED) [B] = A switen
A STANDARD ROUND PIN TERMINAL. = MAKE BEFORE BREAK SWITCH WIPER (SELF RE-SETTABLE) MINOR FILAMENT (SINGLE POLE. SINGLE THROW. - ASWITCH
(THREE OR LESS POSITIONS) = A DUAL FILAMENT BULB |}~ = A RELAY NORMALLY CLOSED) - (DOUBLE POLE. DOUBLE THROW
(O = AGRAPHICS BIG FEMALE TERMINAL ,_(8 = A CIRCUIT BREAKER (W/0 GROUND) : [SINGLE POLE. DOUBLE THROW. © 70| NORMALLY OPEN.GANGED
? =HINGED PALL SWITCH WIPER (FUSE PANEL MOUNTED) CONTACT NORMALLY CLOSED) | v vey
@ - AGRAPHICS BIG MALE TERMINAL (THREE OR LESS POSITIONS) (MANUALLY RE-SETTABLE) @ (SINGLE POLE . SINGLE THROW,
= A HIGH BEAM HEADLAMF . " = A SWITCH
o) = AN INLINE CIRCUIT BREAKER - NORMALLY OPEN. MOMENTARY) (DO! P
@ - A GRAPHICS EMPTY CONNECTOR CAVITY = A PUSH OR PULL SWITCH WIPER (SELF RESETTA = _ S UBLE POLE. DOUBLE
FOR A BIG ROUND TERMINAL. O - BLE) THROW. ONE CONTACT EACH
Q = A MERCURY SWITCH - ? POLE — NORMALLY CLOSED
= A FIXED RESISTANCE = A COIL AND/OR INDUCTOR =ARELAY A SWITCH GANGED) '
0 - A GRAPHICS ARCLESS FEMALE TERMINAL (W/O IRON CORE) (DOUBLE POLE. SINGLE THROW. (SINGLE POLE. DOUBLE THROW.
B - A GRAPHICS ARCLESS MALE TERMINAL - A VARIABLE RESISTANCE @ A CLOCK NORMALLY OPEN) CENTER NORMALLY OPEN) = A SWITCH
%” = A COIL AND/OR INDUCTOR :)Douaue POLE. DOUBLE THROW.
- =A THERMISTOR (WITH IRON CORE} = AMETER (GAUGE) = A SWITCH NE CONTACT EACH POLE —
) ! * - A DIODE ONE CONTACT NORMALLY CLOSEDI COMMON DUAL CONTACT FOR
= APOTENTIOMETER OR A = A HORN o EACH POLE — MOMENTARY)
S . A WIRE TERMINATION %- RHEOSTAT. DEPENDING ON = A RELAY A SWITCH
EXTERNAL CIRCUITY. A SILICON = (DOUBLE POLE. DOUBLE THROW =
Q- AN EVELET TERMINAL GROUND 1 r SILICON CONTROL RECTIFIER | ONE CONTACT — EACH POLE (SINGLE POLE. DOUBLE THROW. = A SWITCH
R T  =AFIXEDCAPACITOR } = ACIGAR LIGHTER 191  NORMALLY CLOSED) CENTER NORMALLY OPEN. {DOUBLE POLE.
. A CHASSIS GROUND * = A ZENER DIODE | BOTH CONTACTS MOMENTARY) DOUBLE THROW.
R A VARIABLE CAPACITOR : ONE COMMON DUAL CONTACT FOR EACH POLE —
H A SINGLE EYELET CONNECTION o NORMALLY CLOSED. TWO CONTACTS PER POLE
- - NORMALLY OPEN)
4 = A HEATER AND/OR TEMPERATURE Iﬂ AN INLINE DIODE
SENSITIVE ELEMENT = A BUZZER
P - AN EYELET CONNECTION TO A STUD.
&  OR ASERIES OF EYELET CONNECTIONS. @ ~ A TRANSISTOR (PNP)
PN = A RELAY —
/ ) WIRE SHIELD LAY oIt i
- =A TRANSISTOR (NPN) = A SPEAKER (SINGLE POLE. (ASISP?('F-SQOID
DOUBLE THROW. = A SOLENOID
ONE CONTACT (DUAL COIL — ONE COIL
NORMALLY CLOSED = A SOLENOID FOR “PULL-IN" AND
PER COIL) (MULTIPLE} N ONE FOR “"HOLDING")
; 3
SPLICED WIRES SHALL BE REPRESENTED BY: :
MOMENTARY CONT,
e) = A SWITCH (PUSH TO CLOSE) —— SONTACT
o (TWO CONTACT. NORMALLY OPEN} {MULTIPLE POSITION SWITCHES|
SPLICE IDENTIFICATION
T = A'SWITCH (PULL TO CLOSE) 6;5 - AswiTe MAKE BEFORE :}\ ﬁs%‘:g&"&
(TWO CONTACT. NORMALLY OPEN) INGLE POLE. THREE POSITION. BREAK WIPER
szfé H & | i Q? BREAK BEFORE MAKE WIPER) ] GANGED WPERS
: S-2!
Q| = A SWITCH
297 BK-LGH 297BK-LGH — 70 REDUCE DRAWING CLUTTER, THE SPLICE SYMBOL MAY BE EXPANDED o”é (SINGLE POLE. FOUR POSITION.
. BEYOND THE SINGLE BLACK DOT, AS SHOWN BELOW. = A SWITCH (PULL TO OPEN) BREAK BEFORE MAKE WIPER)
2 SPLICE (TWO CONTACT. NORMALLY CLOSED) ?Q? MAKE BEFORE — :
BK-LGH BREAK WIPER
SYMBOL ‘ AK WI N
L = A SWITCH 1 FUNCTIONAL TITLE
WHILE: SPLICE SYMBOL SHOWN TWICE. = A SWITCH (PUSH TO OPEN) O (SINGLE POLE. THREE POSITION. [}
BUT IT IS ACTUALLY ONE (TWO CONTACT. NORMALLY CLOSED) 3 BREAK BEFORE MAKE WIPER. 0,0 |
v NO SPLICE SYMBOL SPLICE IN THE WIRING. — TEMPERATURE ACTIVATED) "
2 1
s
= A SWITCH D POSITI 1 SWITCH
(DOUBLE POLE. THREE POSITION. F'XCEONTA%;SON §:g : POSITIONS
3T Y— = A SWITCH (PULL TO CLOSE) BREAK BEFORE MAKE WIPER. 1 S — STAR?
I {THREE CONTACT. NORMALLY OPEN) GANGED) ] R - RUN FUNCTIONS
201 5201 7Y ! | o - orF YLOFswiTcH
IIY— = A SWITCH (PUSH TO CLOSE) = A SWITCH k - kggs POSITIONS
37 |—| (TWO CONTACT. NORMALLY OPEN. ———— (DOUBLE POLE. THREE POSITION. -
Y MOMENTARY) . « MAKE BEFORE BREAK WIPER.
L TWO MOMENTARY CONTACTS PER

l:lu:k Here To Order ‘\

| B, R @8 T

SPLICE IDENTIFICATION
IN WIRE SYMBOL INDICATES
THIS PRACTICE.

MOMENTARY)

= A SWITCH (PULL TO CLOSE)
(TWO CONTACT. NORMALLY OPEN.

POLE. GANGED)

I:YPICAL IGNITION SWITCH
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& _ SOCKET TERMINALS
NOT SHOWN. INTEGRAL
PART OF WIRE ASSEMBLY.

SOCKET HAS
INTERNAL
GROUND

SOCKET TERMINALS
z NOT SHOWN. INTEGRAL
PART OF WIRE ASSEMBLY.
57
z_

SOCKET HAS
NO INTERNAL
GROUND

- -
9 14
GO B8R
A A

9LGO 148R

@_) SOCKET TERMINALS
=/ NOT SHOWN. INTEGRAL

PART OF WIRE ASSEMBLY.

SOCKET TERMINALS

NOT SHOWN. INTEGRAL
PART OF WIRE ASSEMBLY.

1Go 8rR
~__7SOCKET TERMINALS ARE
SHOWN. TERMINALS ARE
PART OF SOCKET. BUT
TERMINALS ON WIRE
Y ASSEMBLY MATE
o SOCKET TERMINALS.
SOCKET HAS
NO INTERNAL
GROUND
o & SOCKET TERMINALS ARE
Lxr’/ SHOWN. TERMINALS ARE

PART OF SOCKET. BUT

% TERMINALS ON WIRE
ASSEMBLY MATE
SOCKET TERMINALS.

| vARIOUS MOTOR TYPES

=AMCTQOR
(SINGLE SPEED. UNIDIRECTIONAL)

=

= A MOTOR — WITH BREAKER
(SINGLE SPEED. UNIDIRECTIONAL
OR BIDIRECTIONAL DEPENDING
ON EXTERNAL CIRCUITRY)

=AMOTOR
(TWO SPEED. UNIDIRECTIONAL)
H = HIGH SPEED
L = LOW SPEED

= AMOTOR
(SINGLE SPEED.
BIDIRECTIONAL)

| I

TYPICAL STARTER MOTOR
(FOUR POLE. UNIDIRECTIONAL)

FI'ERMINALS AND CONNECTORS

[TYPICAL DISTRIBUTORS

4 CYLINDER
DISTRIBUTOR

6 CYLINDER
DISTRIBUTOR

8 CYLINDER
DISTRIBUTOR
351 AND 400

\%4
N B\ scyuLNDER
DISTRIBUTOR
(BREAKERLESS)

8 CYLINDER
DISTRIBUTOR
351 AND 400
(BREAKERLESS)

COMPONENT TERMlNATIONSJ

ELECTRICAL .160 (CONSTANT DISTANCE — USED
CONTINUITY TO INDICATE THAT TERMINALS
TO CASE ‘] ARE PART OF COMPONENT.)
L MALE TERMINAL
ANy ,——-——- DASHED LINE INDICATES
PART OF SAME CONNECTOR
—4 W-BK —R——<
/ 37Y—
STUD TERMINAL L a7y FEMALE TERMINAL

DASHED LINE

INDICATES INDICATES COLOR

CONNECTION OF wiRe

EYELET TERMINALS
TO MATE WITH STUD
TERMINAL ON COMPONENT.

PIGTAIL EXTENDING FROM
COMPONENT. CIRCUIT NUMBER
AND/OR COLOR CODE MUST BE
PROVIDED.

GROUND INDICATIONS

CONTINUITY BETWEEN THESE
TWO SYMBOLS INDICATED BY
POSITION OF SYMBOLS ON
COMPONENT OUTLINE (CHASSIS

G-201
-0— 57 BK ——

EYELET GROUND
ELECTRICAL PATH TO GROUND
PROVIDED BY ATTACHMENT OF
EYELET TERMINAL TO VEHICLE
CHASSIS.

CHASSIS GROUND
ELECTRICAL PATH TO GROUND
PROVIDED WHEN COMPONENT
IS INSTALLED.

SOCKET HAS SOCKET HAS
INTERNAL INTERNAL
GROUND GROUND AS USED ON THE DIAGRAMS. INDIVIDUAL TERMINALS
SHALL BE REPRESENTED BY:
A.—> MALE
T T
e Gox A'Bx B.— FEMALE
'y C. O EYELET
HI BEAM 23\ DuAL BE'GPM TERMINALS PHYSICALLY LOCATED IN THE SAME CONNECTOR
HEADLAMP N HEADLA SHELL MAY BE REPRESENTED SEPARATELY ON THE DIAGRAM. L.E.
Y Y > C-201
g c202 & ¢ OR DESIGNATED AS BEING IN THE SAME CONNECTOR SHELL. I.E.

HEADLAMPS DO NOT HAVE SOCKETS.
AND ARE SHOWN AS ABOVE.

_WDASHED LINE INDICATES TERMINALS ARE

—_— IN SAME CONNECTOR SHELL.
MATING TERMINALS ARE, THEREFORE, REPRESENTED AS:
AN 3 NS 3
}—_—)/ A OR < /:/\': “
C-301 R 77 —

TWO WIRES PHYSICALLY ATTACHED TO A SINGLE TERMINAL

ARE REPRESENTED BY:
> o 77

WIRE TYPES

f 4 DIRECT BATTERY FEED

[ § IGNITION SWITCH CONTROLLED FEED
% - RESISTANCE WIRE
— ALL OTHER

1l L1l 11l

PHOTO UNIT| | MODULATOR ASSEMBLY
BREAKERLESS IGNITION

TYPICAL EXAMPLES OF COMPONENTS WITH
UNDEFINED INTERNALS.

USED IN CASES WHERE COMPONENTS ARE
NOT SERVICEABLE AND ARE CONSIDERED

‘REPLACEABLE ONLY. AND INTERNAL

CIRCUITRY IS NOT CONSIDERED
NECESSARY FOR CLEAR UNDERSTANDING
OF ASSOCIATED WIRING AND COMPONENTS.
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STANDARD WIRE COLOR CODE CHART

CIRCUIT DESCRIPTION
1 HORN SWITCH TO HORN RELAY
2 TURN SIGNAL SW. TO RH FRONT TURN SIGNAL LAMP
3  TURN SIGNAL SWITCH TO LH FRONT TURN SIGNAL LAMP
4 ALTERNATOR REG. “S” TERM. TO ALTERNATOR ““S"” TERM.
6 HORN RELAY TO HORN
8 IGNITION SWITCH TO TURN SIGNAL FLASHER
10  FUSE PANEL TO STOPLAMP SWITCH
11 HEADLAMP SWITCH TO PARKING LAMPS
12 HEADLAMP DIMMER SWITCH TO HIGH BEAMS
13 HEADLAMP DIMMER SWITCH TO LOW BEAMS
15 HEADLAMP SWITCH TO HEADLAMP DIMMER SWITCH
16 IGNITION SWITCH TO IGNITION COIL “BATT.” TERMINAL
17 LOW OIL PRESSURE WARNING LAMP TO LOW OIL PRESS.
SNDG. UNIT
18  AUX. CIRC. BREAKER TO GLOVE BOX LAMP
19 HEADLAMP SWITCH TO INSTRUMENT PANEL LAMPS
21  BATTERY TO IGNITION SWITCH FEED
22 BRAKE FEED
23 CIRCUIT BREAKER TO VOLT. DIVIDER
25 JUNCTION BLOCK TO HEADLAMP SWITCH
26 ALTERNATOR GROUND (NEG. TERM.)
27  WINDSHIELD WIPER CIRC. BRKR. TO W/S WIPER SWITCH
28 WINDSHIELD WIPER SW. TO WINDSHIELD WIPER MOTOR
30 IGN. SW. TO CONSTANT VOLTAGE UNIT & INDICATOR LAMPS
31 OIL PRESS. INDICATOR TO OIL PRESS. SENDING UNIT
32 IGNITION SWITCH TO STARTING MOTOR RELAY
33 BATTERY TO HORN RELAY
34 HEADLAMP DIMMER SW. TO HIGH BEAM INDICATOR LAMP
35 ALTERNATOR REGULATOR “F”” TERM. TO ALTERNATOR
36 ALTERNATOR REGULATOR TO RECTIFIER TERM.
37 LOAD TERM. OF AMMETER TO ALTERNATOR OUTPUT TERM.
38 LOAD THRU AMMETER TO BATTERY
STARTING MOTOR RELAY BATTERY TERM. TO ALT. “A” TERM.
39 TEMP. GAGE TO TEMP. SENDING UNIT
40 BATTERY TO CIGAR LIGHTER
41 WARNING LAMP FEED
42  SWITCH TO WARNING LAMP
43  IGN. TERM. OF IGN. SW. TO LOW AIR BUZZER
44  TURN SIGNAL FLASHER TO TURN SIGNAL SWITCH
45 HOT WATER TEMP. RELAY TO HOT WATER TEMP. SENDING UNIT
48  BLIND CIRCUIT TERMINATING IN HARNESS
49  TURN SIGN. SW. TO RIGHT TURN SIG. INDICATOR LAMP
50 TURN SIG. SW. TO LEFT TURN SIG. INDICATOR LAMP
53 COURTESY LAMP SWITCH TO COURTESY LAMP
54  FUSE PANEL TO COURTESY LAMP SWITCH

~ARGO LAMP SW. TO CARGO LAMP

LD WIPER MOTOR
LD WIPER MOTOR
.. D WIPER MOTOR

COLOR

BLUE-YELLOW STRIPE
WHITE-BLUE STRIPE
GREEN-WHITE STRIPE
WHITE-BLACK STRIPE
YELLOW-GREEN STRIPE
ORANGE-YELLOW STRIPE
GREEN-RED STRIPE
BLACK-YELLOW STRIPE
GREEN-BLACK STRIPE
RED-BLACK STRIPE
RED-YELLOW STRIPE
RED-GREEN STRIPE

WHITE

BLACK-BLUE STRIPE
BLUE-RED STRIPE
YELLOW

BLUE-BLACK STRIPE
ORANGE
BLACK-ORANGE STRIPE
BLACK-RED STRIPE
RED

BLACK-WHITE STRIPE
BLACK-GREEN STRIPE
WHITE-RED STRIPE
RED-BLUE STRIPE
YELLOW
GREEN-BLACK STRIPE
ORANGE
YELLOW-BLACK STRIPE
BLACK-YELLOW STRIPE

BLACK-RED STRIPE
RED-WHITE STRIPE
BLUE-WHITE STRIPE
BLACK-YELLOW STRIPE
RED-WHITE STRIPE
ORANGE-BLUE STRIPE
BLUE

YELLOW-RED STRIPE
BLACK

WHITE—BLUE STRIPE
GREEN-WHITE STRIPE
BLACK-BLUE STRIPE
GREEN-YELLOW STRIPE
BLACK-RED STRIPE
BLUE

BLACK

WHITE-ORANGE STRIPE
BLACK-WHITE STRIPE
YELLOW

RED

GREEN

BLUE

GREEN-WHITE STRIPE
ORANGE-BLACK STRIPE

CIRCUIT DESCRIPTION
69 COIL TERM. IGN. SW. TO FUEL SOLENOID
71 IGNITION SWITCH TO FUSE PANEL
72 ENGINE ALARM RELAY (OIL PRESSURE) TO IND. LAMP
73 LOW AIR BUZZER TO LOW AIR BUZZER SWITCH
74  RELAY “H” TERMINAL TO LAMP (WATER)
75 STARTING MOTOR RELAY TO SERIES PARALLEL SW.
(NO. 1 TERM.)
76 MARKER LAMP FEED (NON TRACTOR) TO AUX. CIRC. BREAKER
78 CIR.BREAKER TO RH & LH MARKER LAMPS
79 CONTROL RECTIFIER TO ALT. REG. “IGN.” TERM.
80 BATTERY TO ENGINE COMPARTMENT LAMP
81 THERMAL SW. TO BLOW MTR. CONTROL RELAY
83 HEADLAMP SW. (REAR LAMP) TO SPEEDOMETER LAMP
84  WINDSHIELD WIPER/WASHER SW. TO FUSE PANEL
87 IGNITION SW. ACCY. TERM. TO CIRC. BREAKER
88  INSTR. PANEL LAMP SWITCH FEED
89 GLOWPLUG TO GLOW PLUG SWITCH
90 AIR PRESSURE GAGE TO TRANSMITTER
92 ELECT. FUEL PUMP TO AUX. CIRC. BREAKER
93 STARTER SWITCH TO ELECT. FUEL PUMP
95 WINDSHIELD WIPER CONTROL SWITCH TO GROUND
96  WINDSHIELD WIPER CONTROL SW. TO W/S WIPER MOTOR GRND.
98  ““A” TERM. IGN. SW. TO ALT. REG. “IGN.” TERM.
99 CONTROL SWITCH TO IGNITION SWITCH
100 CONTROL SWITCH TO VOLTAGE REGULATOR
109 BATTERY TO STARTING MOTOR RELAY FEED
110 FUEL TANK SOLENOID VALVE TO AUX. CIRC. BREAKER
113 STARTING MOTOR TO STARTING MOTOR RELAY
118 HEATER RELAY TO HEATER CIRC. BREAKER
120 CIRCUIT BREAKER (POWER & CHARGING) TO FUSE PANEL
128 STARTING MOTOR RELAY TO STARTING MOTOR
129 GLOWPLUG C. B. TO GLOW PLUG SW.
130 ACCESSORY RELAY “ARM./TERM.” TO ACCY. TERM. OF
FUSE PANEL
132 MOTOR TO GROUND (2 SPEED AXLE)
136 TWO SPEED AXLE SWITCH TO TWO SPEED ADAPTOR
137 FUSE PANEL TO RADIO
139  IGN. SW. “ACC.” TERM. TO BATT. TERM. OF CIRCUIT BRKR.
140 BACK UP LAMP SWITCH TO BACK UP LAMP
141 TWO OR THREE SPD. AXLE SW. TO TWO OR THREE SPD.
AXLE MTR.
142 TWO OR THREE SPEED AXLE CIRCUIT BREAKER LOAD TERM.
TO TWO OR THREE SPEED AXLE TERMINAL
143 TWO OR THREE SPD. AXLE SW. TO TWO OR THREE SPD.
AXLE MTR.
144  CIRCUIT BRKR. LOAD TERM. TO NO. 142 SPLICE (2 SPEED
AXLE SHIFT)
145 SPEEDO. ADAPTOR TO NO. 141, NO. 146 SPLICE (2 SPEED
AXLE SHIFT)
146  SHIFT MOTOR TO NO. 141, NO. 145 SPLICE (2 SPEED
AXLE SHIFT)
147  SHIFT MOTOR TO NO. 143 SPLICE (2 SPEED AXLE SHIFT)
148 HEADLAMP SW. TO AUTO. TRANS. IND. LAMP
149  AUX. LAMP CIRCUIT BREAKER LAOD TERM. TO AUX. LAMP
FEED HEADLAMP SWITCH “C"” TERMINAL
1560 BATTERY FEED TO FUSE PANEL

COLOR

RED-GREEN STRIPE
BLACK

GREEN
ORANGE-GREEN STRIPE
GREEN

GREEN-RED STRIPE
BLACK-GREEN STRIPE
BLUE-YELLOW STRIPE
GREEN-RED STRIPE
BLACK-WHITE STRIPE
BROWN

BLACK

RED

GREEN-ORANGE STRIPE
BLACK-WHITE STRIPE
ORANGE

GREEN-WHITE STRIPE
BLUE

BLUE-YELLOW STRIPE
WHITE

ORANGE-BLACK STRIPE
BLACK

BLACK

BLACK-RED STRIPE
YELLOW
BLACK-GREEN STRIPE
YELLOW-BLACK STRIPE
RED

BLACK

BLACK

GREEN

YELLOW

GREEN

BLACK
YELLOW-BLACK STRIPE
GREEN-YELLOW STRIPE
BLACK-RED STRIPE
BLACK

GREEN

RED

GREEN

BLACK

BLACK

RED

BLACK-BLUE STRIPE

YELLOW
RED
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STANDARD WIRE COLOR CODE CHART (CONTINUED)

CIRCUIT DESCRIPTION

151  SPEED CONTROL ON-OFF SWITCH TO AMPLIFIER

152  ALT. OUTPUT “A’ TERM. TO VOLTAGE REG. “A” TERM.

153 STARTING MOTOR RELAY TO FLASHER

154  AIR TANK VALVE

156  AIR TANK VALVE FEED

158 KEY WARNING SWITCH TO BUZZER

159 DOOR JAMB SWITCH TO BUZZER

160 BUZZER TO WARNING INDICATOR RELAY

161  IGN. SW. (ACC. TERM.) TO EMERG. BRAKE WARNING LAMP

162 EMERG. BRAKE WARNING LAMP TO EMERG. BRAKE SWITCH

181  FUSE PANEL TO HEATER BLOWER MOTOR

182  AIR COND. CIRC. BRKR. (LOAD TERM) TO THERMOSTAT SW.

183  AIR COND. CIRC. BRKR. (LOAD TERM) TO A/C BLOWER
SW. FEED

184  AIR COND. SW. (LOW) TO AIR COND. BLOWER MOTOR

185  AIR COND. SW. (HIGH) TO AIR COND. BLOWER MOTOR

188 CIRCUIT BRKR. TO HEADLAMP SW. “BATT.” TERM.

189 TERM. BLOCK TO CIRCUIT BREAKER

190  IGNITION SW. ACCY. TERM. TO AIR COND. CIRCUIT BREAKER

195 EMERG. BRAKE SW. TO SIGNAL LAMP & RESISTOR GND.

196  ACCY. FEED FROM FUSE PANEL TO RELAY

197  AUX. ACCY. FEED FROM RELAY

198 BATT. TERM. OF STARTER SOLENOID TO RELAY

199 CIRCUIT BREAKER FEED

200 CIRCUIT BREAKER TO SPLICE

201  SPLICE TO HEADLAMP SWITCH

203 INTERIOR LAMP PICKUP BOX COVER

205 CIRC. BRKR. LOAD TERM. TO STOPLAMP WRNG. RELAY
ARM. TERM.

206 GROUND RETURN TO TOWING VEHICLE

207 MARKER LAMP SWITCH TO MARKER LAMPS

208 WATER TEMP. SW. (HOT) TO DELAY & CONTROL RELAY

209 STOPLAMP SW. TO RELAY

210  INDICATOR LAMP TO SWITCH

212 AUX. CIRC. FEED TO TRACTOR TRAILER PLUG

213  OIL LEVEL SENDER TO SIGNAL UNIT (LAMP)

214  SIGNAL UNIT (LAMP) TO TEMP. SIGNAL LAMP

215  SIGNAL UNIT (LAMP) TO FUEL SIGNAL RELAY

221 IGNITION SW. “ACCY. TERM’* TO HEATER TEMPERATURE
SW. FD.

222 TEMPERATURE CONTROL SW. TO HEATER MOTOR BLOWER SW.

230 EMISSION CONTROL VALVE TO SWITCH

231 “L"” TERM. VOLTAGE REG. TO ACCESSORY TERM. IGN. SW.

232 ELECTRONIC SW. TO IGN. COIL NEG. TERM.

233  WINDSHIELD WASHER MOTOR TO IGN. SW.

234  WINDSHIELD WASHER MOTOR TO IGN. SW.

235 ALTERNATOR RELAY TO ALTERNATOR REGULATOR

5 252 CIRCUIT BREAKER (LOAD) TO 3 SPEED AXLE SWITCH
253 INTERMEDIATE TERMINAL 3 SPEED AXLE SWITCH TO SOLENOID

BUY/ITINOW!

Click Here To Drder

\ALVE FORWARD TANDEM

:RM. 3 SPEED AXLE SW. TO SOLE. VALVE RR. TANDEM
"BREAKER (LOAD) TO AXLE LOCKOUT DIFFERENTIAL
ORY TERM IGN. SW. TO 3 SPEED AXLE SWITCH

. “ACCY. TERM.” TO BLOWER MOTOR

BRAKE WARNING LAMP TO EMERG. BRAKE SWITCH
. O EMERG. BRAKE WARNING LAMP

| B, R @8 T

COLOR

BLUE:BLACK STRIPE
YELLOW

RED-WHITE STRIPE
RED

BLUE

BLACK-WHITE STRIPE
RED

WHITE

GREEN

GREEN-RED STRIPE
ORANGE
BROWN-WHITE STRIPE

BROWN

RED

BLACK

BLACK
GREEN-YELLOW STRIPE
YELLOW

RED

RED

RED-BLUE STRIPE
BLACK

BLACK-ORANGE STRIPE
BLUE

BLUE-YELLOW STRIPE
WHITE-YELLOW STRIPE

GREEN

WHITE

BLACK

RED-WHITE STRIPE
YELLOW

BLUE

BLUE

RED

RED-BLACK STRIPE
YELLOW-BLACK STRIPE

BLUE

RED

BROWN-YELLOW STRIPE
YELLOW-BLACK STRIPE
GREEN-YELLOW STRIPE
GREEN

BLACK

YELLOW-BLACK STRIPE
GREEN

RED

BLACK

BLUE

GREEN

YELLOW

BLACK

BLACK-RED STRIPE

CIRCUIT DESCRIPTION

260 BLOWER MOTOR TO SWITCH — LO

261 BLOWER MOTOR TO SWITCH — HlI

262 STARTING MOTOR RELAY TO IGN. COIL “I” TERM.

263 CLICKER RELAY TERM. NO. 4 TO AIR VALVE ASSY.

264 CLICKER RELAY TERM. NO. 3 TO AIR VALVE ASSY.

265 CLICKER RELAY TERM. NO. 1 TO SPEED CONTROL BRAIN

266 BRAKE SW. TO CLICKER RELAY TERM. NO. 4

267 CONTROL HEAD MAKE READY SW. TO BRAKE SW.

268 HEATER SW. TO HEATER BLOWER MOTOR (LOW)

269 HEATER SW. TO HEATER BLOWER MOTOR (MEDIUM)

270 HEATER SW. TO HEATER BLOWER MOTOR (HIGH)

271 AIR COND. MASTER SW. TO “F” TERM. OF FAST IDLE
RELAY

272 NEUTRAL SWITCH TO “B” TERM. OF FAST IDLE RELAY

273  IGN. SWITCH TO FAST IDLE RELAY

274  FAST IDLE RELAY TO STARTING MOTOR RELAY

275  FAST IDLE RELAY “A"” TERM. TO FAST IDLE SOLENOID

276  STARTING MOTOR RELAY TO NEUTRAL SWITCH

277 BLOWER MOTOR TO SWITCH

280 COORDINATOR SW. TO WINDSHIELD WIPER MOTOR

281 COORDINATOR SW. TO WINDSHIELD WIPER MOTOR

282 TURN SIGNAL SW. TO RH REAR TURN SIGNAL LAMP

283 TURN SIGNAL SW. TO LH REAR TURN SIGNAL LAMP

284 BATTERY FEED TO STOPLAMP SWITCH

285 “R” TERMINAL HEADLAMP SWITCH TO REAR LAMPS

286 FUEL GAGE INDICATOR TO TANK SENDING UNIT

288 “R"” TERM. OF ALT. REG. TO ALT. “R"” TERM.

289  FAST IDLE RELAY “A” TERM. TO COMPRESSOR CLUTCH

292 REAR TERM. OF HEADLAMP SW. TO STORAGE COMPT. LAMP

296  FUSE PANEL ACCY. FEED TO SPLICE

297  IGN. SW. (ACCY. TERM) TO FUSE PANEL ACCY. FEED

331  WINDSHIELD WASHER SW. (FLOOR) TO W/SHIELD WIPER SW.

332 WINDSHIELD WASHER SW. FEED (FLR.) TO IGN. SW. ACCY.
TERM

345 RELAY NO. 1 TERM. TO POST. TERM. VOLT. REG.

346 RELAY NO. 2 TERM. TO BATT. TERM. START RELAY

347 THERMOSTATIC SW. TO CLUTCH

348 THERMOSTATIC SW. TO AIR COND. SW. SELECTOR TERM.

349 THERMOSTATIC SW. TO AIR COND. SW.

350 AIR COND. SW. “HI” TERM. TO CLUTCH RELAY "“BATT.”
TERM.

351 CLUTCH RELAY TO CLUTCH

358  IGN. SW. (ACCY. TERM) TO AIR COND. EVAPORATOR
MOTOR SW.

359 EVAPORATOR THERMOSTAT TO COMPRESSOR CLUTCH

360 SPEED CONTROL BRAKE SW. TO SPEED CONTROL IND. LAMP

364 ACCY. TERM. IGN. SW. (FUSE PANEL) TO BLWR. (COIL
TERM) MTR. RELAY

369 VACUUM SOLENOID TO TEMP. SW.

370  AIRSHIFT SW. TO BATT. TERM. OF IGN. SW.

371  BLOWER MOTOR RELAY (LOAD TERM) TO BLOWER MOTOR

373 BATTERY FEED TO CIRCUIT BREAKER (BATT. TERM)

374 STARTING MOTOR RELAY TO ENGINE USAGE INDICATOR

376 HORNBUTTON TO HORN

377 AUX. CIRCUIT BRKR. TO HORN BUTTON

383 EMERGENCY WARNING FLASHER FEED

COLOR

RED-BLACK STRIPE
ORANGE-BLACK STRIPE
BROWN

RED

BLUE

WHITE

YELLOW
BLACK-YELLOW STRIPE
RED-BLACK STRIPE
BLUE-RED STRIPE
BLACK-YELLOW STRIPE

BLUE

GREEN

YELLOW

RED

BLACK

YELLOW

GREEN

WHITE-GREEN STRIPE
BLUE-BLACK STRIPE
GREEN
YELLOW-BLACK STRIPE
RED

BROWN

ORANGE
WHITE-BLACK STRIPE
BLACK

WHITE

RED

BLACK-GREEN STRIPE
RED

YELLOW
GREEN-WHITE STRIPE
WHITE-GREEN STRIPE
BLACK

GREEN-WHITE STRIPE
BROWN

YELLOW
RED

YELLOW
BLACK-WHITE STRIPE
YELLOW-BLUE STRIPE

BLACK-GREEN STRIPE
BROWN

YELLOW

RED

YELLOW

RED

BLUE-YELLOW STRIPE
YELLOW-BLUE STRIPE
RED-WHITE STRIPE
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CIRCUIT DESCRIPTION

384 FLASHER TO EMERGENCY WARNING LAMP

385 FLASHER TO EMERGENCY WARNING SWITCH

386 FLASHER TO EMERGENCY WARNING INDICATOR

388 AUX. CIRCUIT BREAKER FEED

399 FUSE PANEL TO HEATER BLOWER SWITCH

450  IGN. SW. TO SEAT BELT WARNING INDICATOR LAMP FEED

451 SEAT BELT WARNING LAMP TO SEAT BELT WARNING IND.
RELAY TERM. NO. 1

452  IGN. SW. TO SEAT BELT WARNING IND. RELAY TERM NO. 4

453  SEAT BELT WARNING IND. GRD. SW. TO S/B WRNG. IND.
RELAY TERM. NO. 2

454  IGN. SW. COIL TERM. TO CIRCUIT BREAKER

455 CIRCUIT BREAKER TO FUEL VALVE

460 BATTERY TO HORN SWITCH

469  IGN. SW. ACCY. TERM. TO SEAT BELT WARNING SWITCH

474  IGNITION SW. (ACCY.) TO STOPLAMP RELAY (BATT. TERM.)

475 STOPLAMP SW. TO STOPLAMP RELAY (COIL TERM.)

477 CIRCUIT BREAKER TO FOG LAMP SWITCH

478 FOG LAMP SWITCH TO FOG LAMP

480 HI LAMP FEED FROM HEADLAMP SWITCH TO FUSE PANEL

483 INHIBITOR SWITCH TO MAKE READY SWITCH

484 CLICKER RELAY TERM. NO. 1 TO RESUME SPEED SWITCH

489 EMERGENCY FLASHER SWITCH TO STOPLAMP RELAY

490 IGNITION SWITCH TO TRANSMISSION INDICATOR LAMP

491 CIRC. BREAKER (BATT. TERM) TO STOPLAMP RELAY
( BATT. TERM)

492 STOPLAMP RELAY (ARM TERM.) TO TURN SIGNAL SWITCH

509 AIR COND. CONDENSOR THERMAL SWITCH FEED

510 AIR COND. CONDENSOR THERMAL SW. TO BLOWER MOTOR

511  STOPLAMP SW. TO TURN SIGNAL SW.

512 SWITCH TO TRAILER AUX. LAMPS

513 CIRCUIT BREAKER TO STOPLAMP RELAY FEED

514 EMERGENCY WRNG. SW. TO EMERG. WRNG. RELAY COIL TERM.

515 HEATER RESISTOR TO BLOWER MOTOR (HI)

519  GLOW PLUG SW. TO LAMP (FEED)

520 SEAT BELT WARNING LAMP TO WARNING LAMP SWITCH

526 CIRCUIT BREAKER TO MARKER LAMP SW. FEED

532  IGNITION SWITCH TO VACUUM SWITCH

533 VACUUM SWITCH TO INDICATOR LAMP

536 BLOWER MOTOR RELAY (LOAD TERM) TO BLOWER MOTOR

537 COMPRESSOR TO CLUTCH

546 STARTER CONTROL TO INTERLOCK MODULE

560 SEAT BELT WRNG. TIMER TO L.F. RETRACTOR SWITCH

561 SEAT BELT WRNG. TIMER TO R.F. SEAT SENSOR

562 SENSOR SIGNAL TO AMPLIFIER

563 AUX. HEADLAMP SW. TO AUX. HD. LAMP RELAY

564 HEADLAMP SW. TO AUX. HEADLAMP RELAY

STANDARD WIRE COLOR CODE CHART (CONTINUED)

xA_UX HEADLAMPS TO AUX. HD. LP. RELAY

COLOR

WHITE-BLUE STRIPE
WHITE-RED STRIPE
YELLOW
YELLOW-RED STRIPE
BROWN

GREEN

BLACK-RED STRIPE
GREEN-WHITE STRIPE

BLACK-YELLOW STRIPE
RED-GREEN STRIPE
GREEN-RED STRIPE
YELLOW

GREEN

RED

GREEN-WHITE STRIPE
BLUE-BLACK STRIPE
GRAY
YELLOW-ORANGE STRIPE
YELLOW-BLUE STRIPE
BLACK

ORANGE

BLUE-RED STRIPE

RED-WHITE STRIPE
GREEN

YELLOW

ORANGE

GREEN

BLACK

BROWN

BLUE

ORANGE

WHITE
VIOLET-WHITE STRIPE
BLACK-WHITE STRIPE
ORANGE

BLACK

BLACK

YELLOW

WHITE-PINK STRIPE
BROWN-BLUE STRIPE
BLUE-WHITE STRIPE
GREEN-WHITE STRIPE
BROWN

ORANGE

BLUE

GREEN
ORANGE-WHITE STRIPE
YELLOW-GREEN STRIPE
RED-WHITE STRIPE
RED-BLACK STRIPE
BLUE

GREEN

YELLOW

CIRCUIT DESCRIPTION

579 RELAY TO JUNCTION BLOCK

580 FUSE PANEL TO ANTI-SKID

581 FAILURE MODULE TO RELAY

583 INTERMITTENT GOV. TO INTERMITTENT GOV. FEED

584  IGN. SW. TO SEAT BELT WARNING IND.

587 W/SHIELD WIPER SW. TO INTERMITTENT GOVERNOR FEED

588  W/SHLD. WIPER MOTOR DYN. BRAKE TO W/S WIPER SW. GRND.

589  W/SHLD. WIPER SW. TO INTERMITTENT GOV. GRND. DYN. BRKG.

590 INTERMITTENT GOVERNOR TO W/S WIPER SWITCH

591 SPEED CONTROL RELAY TO SPEED REGULATOR

592 STOPLAMP SW. TO SPEED CONTROL RELAY

593 SPEED CONTROL ACTUATOR TO CUTOUT RELAY

594 TEMP. TRANSMITTER TO IND. LAMP (ENGINE COLD)

536 PRIMER SW. TO OIL PRESSURE SAFETY SWITCH

597  COIL TERM. OF IGN. SW. TO OIL PRESSURE SAFETY SW.

598 COIL TERM. OF IGN. SW. TO FUEL PUMP PRIMER SWITCH

599  START TERM. OF IGN. SW. TO FUEL PUMP PRIMER SWITCH

600 FAILURE MODULE TO TANDEM RR. AXLE CONTROLLER

601 BRAKE SKID CONTROL MODULE FEED

602 COIL TERM. OF IGN. SW. TO BRAKE SKID CONTROL MODULE

603 DUAL BRAKE WARNING LIGHT TO BRAKE SKID CONTROL
MODULE

604 SKID CONTROL MODULE TO R. H. WHEEL SENSOR (HIGH)

605 SKID CONTROL MODULE TO R. H. WHEEL SENSOR (LOW)

606 SKID CONTROL MODULE TO L. H. WHEEL SENSOR (HIGH)

607 SKID CONTROL MODULE TO L. H. WHEEL SENSOR (LOW)

608 FAILURE MOD. TO FRONT AXLE CONTROL

609 ESOTP MODULE TO THERMOCOUPLE (NEG.)

610 THERMOCOUPLE (—) MODULE TO SENSOR

611  THERMOCOUPLE (+) MODULE TO SENSOR

612 AIR DUMP VALVE (-) TO MODULE

613 EGR VALVE (=)

614 SPEED SENSOR

615 FEED TO FAILURE SWITCH

617 FUSE PANEL TO SKID CONTROL MODULE

618 FAILURE MOD. TO RR. AXLE CONTROL

619 FAILURE MOD. TO RR. AXLE CONTROL

620 FAILURE MOD. TO RR. AXLE CONTROL

621 FAILURE MOD. TO FRONT AXLE CONTROL

622 FAILURE MOD. TO FRONT AXLE CONTROL

625 IGNITION SW. COIL TERM. TO PRIMER SWITCH

629 FAILURE MOD. TO RR. AXLE CONTROL

630 FUSE PANEL TO FAILURE INDICATOR RELAY

631 FAILURE MOD. TO TAN. RR. AXLE CONTROL

632 IGN. SW. COIL TERM. TO OIL TEMP. WARNING LAMP

633 IGN. SW. TO OIL TEMP. WARNING RELAY

634  OIL TEMP. WARNING RELAY TO OIL TEMP. WARNING LAMP

635 OIL TEMP. WARNING LAMP TO OIL TEMP. WARNING SWITCH

636 OIL TEMP. WARNING RELAY TO OIL TEMP. SW.

637 OIL TEMP. WARNING RELAY TO FLASHER

638 FLASHER TO OIL PRESS. SWITCH

639 FLASHER TO OIL TEMP. WARNING LAMP

640 IGN. SWITCH COIL TERM. TO WARNING LAMPS

641  IGN. SWITCH GROUND TERM. TO WARNING LAMP

642 WATER TEMP. WARNING LAMP TO WATER TEMP. SW. (COLD)

643 CHARGE INDICATOR LAMP TO SPLICE

COLOR

BLACK-ORANGE STRIPE
BLUE

GREEN-WHITE STRIPE
BLACK

GREEN-BLUE STRIPE
BLACK-WHITE STRIPE
WHITE-BLACK STRIPE
ORANGE

BLUE-WHITE STRIPE
BLACK-ORANGE STRIPE
BLUE-WHITE STRIPE
YELLOW

GREEN

BLACK

RED

RED-BROWN STRIPE
RED-BLUE STRIPE
BLUE-BLACK STRIPE
BLUE

RED-PURPLE STRIPE

GREEN

YELLOW

BROWN

YELLOW

BROWN

BLUE-WHITE STRIPE
RED

RED-YELLOW STRIPE
YELLOW

BLUE

BROWN

GREEN
BLACK-YELLOW STRIPE
BLACK-GREEN STRIPE
RED

GREEN-YELLOW STRIPE
BLUE

GREEN

RED-WHITE STRIPE
BLUE

RED-BLACK STRIPE
WHITE

GREEN-BLACK STRIPE
BLACK

RED

BLUE

GREEN

GREEN

BLACK

YELLOW
YELLOW-RED STRIPE
RED-YELLOW STRIPE
BLACK-RED STRIPE
WHITE-GREEN STRIPE
YELLOW-BLACK STRIPE
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CIBCIT DESCRIPTION
644  OIL TEMP. WARNING LAMP TO IGN. SWITCH (ACCY. TERM.)
645 IGNITION SWITCH COIL TERMINAL TO TACHOMETER
646 TACH. THRU IGN. RESISTOR TO BATTERY TERM. OF IGN. COIL
647 WATER TEMP. WARNING LAMP TO WATER TEMP. SWITCH (HOT)
648 IGNITION SW. COIL TERMINAL TO TACHOMETER
649 TACHOMETER TO IGNITION COIL “B” TERM.
654 ALT. SHUNT “A” TERM. TO AMMETER
655 STARTING MOTOR RELAY SHUNT TO AMMETER
666 DOME LAMP FEED
668 IGN. RELAY TO STARTING MOTOR RELAY
669 IGN. RELAY TO STARTING MOTOR RELAY START TERM.
670 FAILURE INDICATOR TO MODULE
671 SPEED REG. SW. “ON" POSITION TO ON & OFF RELAY
672 SELECTOR SW. TO LEFT HAND PUMP MOTOR
673 SELECTOR SW. TO LEFT FUEL GAGE
674 SELECTOR SW. TO RIGHT HAND PUMP MOTOR
675 SELECTOR SW. TO RIGHT FUEL GAGE
676 L. H.SENSOR FEED JUNCTION BLOCK TO CONTROLLER
677 L. H.SENSOR COMMON JUNCTION BLOCK TO CONTROLLER
678 R.H.SENSOR COMMON JUNCTION BLOCK TO CONTROLLER
679 R.H.SENSOR FEED JUNCTION BLOCK TO CONTROLLER
682 H/L SW. BATT. TERM. TO TRACTOR—TRAILER RELAY “B" TERM.
683  H/L SW. “R” TERM. TO TRACTOR—TRAILER RELAY “F" TERM.
684 TRACTOR—TRAILER RELAY “A” TERM. TO MARKER LAMP SW.
685 TRACTOR—TRAILER RELAY CIRC. BRKR. TO AUX. MARKER
LAMP SW.
689 ENG. SPEED SENSOR UNIT TO MANIFOLD VACUUM SENSING SW.
690 HYDRO-BOOST SW. TO WARNING LAMP
691 SKID CONTROL MODULE TO AXLE SENSOR
692 SKID CONTROL WARNING RELAY TO SKID CONT. MODULE
693 BRAKE SYSTEM WARNING RELAY TO SW.
694 TURN SIG. FLASHER “P” TERM. TO TURN SIGNAL
IND. LAMPS
697 SPEED REG. SW. “OFF" POSITION TO ON & OFF RELAY
704 FRONT RADIO SPEAKER VOICE COIL GROUND
705 CIRCUIT BREAKER TO HEATER BLOWER SWITCH
708  RADIO SPEAKER VOICE COIL FEED
730 BATTERY TO VOLT METER
733 AMPLIFIER GROUND BREAKER LESS MODULE TO DISTRIBUTOR
734  AMPLIFIER TO SERVO TRANSDUCER FEED
735 AMPLIFIER FEEDBACK POTENTIOMETER FEED
737  AIR CONDITIONER MOTOR TO GROUND

STANDARD WIRE COLOR CODE CHART (CONTINUED)

FUEL PUMP RELAY “H” TERMINAL TO OIL PRESSURE SWITCH
FUEL PUMP RELAY TO SELECT SWITCH “B"” TERMINAL
IGNITION SWITCH (COIL TERM.) TO FUEL PUMP RELAY
IGNITION SWITCH (ACCY. TERM.) TO FUEL PUMP RELAY
FUEL PUMP RELAY TO FUEL PUMP

FUEL PUMP RELAY TO OIL PRESSURE SW.

FUSE PANEL TO RADIO RECEIVER

*/22220E SHIFT TO HEATER CONTROL SWITCH

'ECEIVER TO F. M. TUNER FEED

M. OF IGN. SW. TO W/S WIPER CIRCUIT BREAKER
‘R CIRCUIT BREAKER TO W/S WIPER MOTOR

LT SW. FEED “P"” TERM.

* LAMP SWITCH TO BLINK SWITCH

COLOR

RED-GREEN STRIPE
BLACK

RED

RED

RED

RED-GREEN STRIPE
YELLOW-BLACK STRIPE
RED-ORANGE STRIPE
RED

BLACK

RED-BLUE STRIPE
PINK

WHITE

BROWN

GREEN

BROWN-WHITE STRIPE
GREEN-RED STRIPE
ORANGE

GREEN

GREEN-WHITE STRIPE
ORANGE-WHITE STRIPE
YELLOW

BROWN

BLACK-WHITE STRIPE

BLACK-RED STRIPE
PURPLE
GREEN-WHITE STRIPE
YELLOW

BROWN

BROWN

BROWN
ORANGE-BLACK STRIPE
BLACK-RED STRIPE
BROWN
BLACK-ORANGE STRIPE
RED

BLACK-GREEN STRIPE
ORANGE-YELLOW STRIPE
PURPLE-BLUE STRIPE
GREEN
GREEN-ORANGE STRIPE
RED-YELLOW STRIPE
GREEN

RED

BLUE

YELLOW

BLACK

BLUE

BLACK

ORANGE-WHITE STRIPE
BLACK-ORANGE STRIPE
YELLOW

WHITE-BLACK STRIPE

CIRCUIT DESCRIPTION

780 ENGINE ALARM RELAY (OIL PRESS.) “F” TERM. TO “A"”
TERM. IGNITION SWITCH

781 BRAKE PAD SWITCH TO HOLDING RELAY

784 STEREO SPEAKER VOICE COIL RETURN

786 FUEL PUMP PRIMER SW. TO FUEL PUMP RELAY

787 FUEL PUMP SAFETY SWITCH TO FUEL PUMP MOTOR

789 VACUUM SWITCH TO HOLDING RELAY

795 NEUTRAL SAFETY RELAY TO NEUTRAL SWITCH

796  ACCESS. FEED TO NEUTRAL SAFETY RELAY

797 BATTERY FEED TO STEREO

804 FADER CONTROL TO FADER ARM (LEFT CHANNEL)

805 FADER CONTROL TO FADER ARM (RIGHT CHANNEL)

806 SPEAKER VOICE COIL FEED (RIGHT CHANNEL)

807 SPEAKER VOICE COIL FEED (LEFT CHANNEL)

808 SELECTOR SWITCH TO FUEL TANK SOLENOID VALVE

809 STOPLAMP SWITCH TO STOPLAMP

810 STOPLAMP SWITCH TO STOPLAMP

811 RELAY “A” TERM. TO TRAILER TAIL LAMPS

812 MARKER LAMP SWITCH TO MIRROR LAMP

813 BRAKE SWITCH TO TRAILER RELAY “B” TERM.

814  IGN. SWITCH COIL TERM. TO VOLTAGE RELAY

816 CIRCUIT BREAKER TO REVERSE RELAY FEED

822 FRONT SPEAKER TO FADER CONTROL SWITCH

823 FADER CONTROL SWITCH TO RADIO

824 FRONT SPEAKER TO RADIO

825  SERVO SOURCE VACUUM SOLE. TO CONTROL TRANSISTOR

826 SERVO VENT VACUUM SOLE. TO CONTROL TRANSISTOR

827 SERVO FEEDBACK POTENTIOMETER SIGNAL TO AMPLIFIER

828 SERVO FEEDBACK POTENTIOMETER BASE TO AMPLIFIER

829  IGN. SW. (ACCY. TERM.) TO VACUUM SOLENOID

830 SENSOR SIGNAL TO AMPLIFIER

832 CONTROL RELAY TO HOLDING RELAY

833  IGN. SW. ACCY. TERM. TO EMERGENCY STOP LAMP SW.

836 INDICATOR LAMP TO FLASHER

837 FLASHER TO EMERGENCY BRAKE SWITCH

838 THERMAL RELAY TO LOCK IN VALVE

839 BATTERY TO STOP LAMP CIRCUIT BREAKER

847 STARTER RELAY SOLENOID “SM"” TERM. TO C. S. RELAY
COIL

848 BALLAST RESISTOR “E” TERM. TO TRANSISTOR UNIT
“E” TERM.

849 STARTING MOTOR RELAY TO TACH BLOCK

850 BALLAST RESISTOR COIL TERM. TO IGN. COIL BATT. TERM.

851 TRANSISTOR UNIT “B"” TERM. TO DISTRIBUTOR

852 TRANSISTOR UNIT “C” TERM. TO BALLAST RESISTOR
“C"” TERM.

853  COIL TERM. IGN. SW. TO BALLAST RESISTOR “E” TERM.

854 C.S. RELAY TO STARTER SOLENOID 1" TERM.

856 TRANSISTOR UNIT TO PICK-UP COIL

856 PICK-UP COIL TO TRANSISTOR UNIT

857  TRANSISTOR UNIT TO START TERM. TO STARTER RELAY

858 MAKE READY SWITCH TO BRAKE PEDAL PAD SWITCH

859 BRAKE PEDAL PAD SWITCH TO CONTROL RELAY TERM. NO. 4

860 MAKE READY SWITCH TO SET SPEED SWITCH

861 RETARD SWITCH TO CONTROL RELAY TERM. NO. 7

COLOR

RED

BROWN

VIOLET

RED

RED-BROWN STRIPE
BROWN-WHITE STRIPE
RED-BLACK STRIPE
BLACK

GREEN

RED

BLUE

WHITE

ORANGE
BROWN-ORANGE STRIPE
RED-BLACK STRIPE
RED-BLACK STRIPE
BROWN

BLUE

YELLOW-BLACK STRIPE
WHITE

YELLOW-BLUE STRIPE
BROWN

GREEN

BLUE

GRAY-BLACK STRIPE
WHITE-PINK STRIPE
YELLOW-RED STRIPE
BROWN-GREEN STRIPE
RED

GREEN-WHITE STRIPE
YELLOW-BLACK STRIPE
GREEN

RED

BLACK
ORANGE-BLACK STRIPE
WHITE

WHITE

RED-WHITE STRIPE
BROWN
BLUE-WHITE STRIPE
GREEN

BLUE

RED-GREEN STRIPE
BROWN

VIOLET

ORANGE

WHITE

RED

YELLOW
VIOLET-WHITE STRIPE
BLUE-WHITE STRIPE
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STANDARD WIRE COLOR CODE CHART (CONTINUED)

CIRCUIT DESCRIPTION
862 RESUME SWITCH TO CONTROL RELAY TERM. NO. 8
863 BRAKE SWITCH TO HOLDING RELAY
864 BRAKE SWITCH TO 20 M.P.H. SWITCH
865 SELECTOR SWITCH TO WARNING LAMP (LOW OIL PRESSURE)
866 CONTROL SWITCH TO OIL PRESSURE PUMP
867 IGNITION SWITCH TO OIL PRESSURE SWITCH
868 OIL PRESSURE SWITCH TO CONTROL SWITCH
869 RETARD VALVE TO CONTROL RELAY TERM. NO. 1
870 EMERGENCY STOP LAMP SWITCH TO TRACTOR—TRAILER PLUG
871 LOCK-IN VALVE TO CONTROL RELAY TERM. NO. 2
872 STARTER MOTOR RELAY TO CONTROL RELAY TERM. NO. 11
873 HEADLAMP SWITCH ““R” TERM. TO ASH RECPT. LAMP FEED
876 HEADLAMP SW. BATT. TERM. TO ALT. “A” TERM.
877 ALT.”F” TERM. TO REG. “F"” TERM.
878 REG.”A” TERM. TO IGN. SW. COIL TERM.
879 BLOWER SW. MED. NO. 1 THRU RESISTOR TO HI BLOWER
MOTOR FIELD
880 BLOWER SW. MED. NO. 2 TO LOW BLOWER MOTOR FIELD
881 20 MPH SWITCH TO CONTROL RELAY TERMINAL NO. 16
882 A/C BLOWER SW. TO A/C REFRIGERANT SOL. FEED
883 CIRCUIT BREAKER TO A/C CONTROL RELAY
884 A/C CONTROL RELAY TO A/C SW. (FEED)
885 ACCY.TERM. IGN. SW. TO A/C CONTROL RELAY
886 LAMP TO SENDING UNIT
887  SPLICE TO OIL TEMP. ENG.
888 W/SHIELD WIPER SWITCH TO RELAY
889 W/SHIELD WIPER SWITCH TO RELAY
890 W/SHIELD WIPER SW. TO RELAY
891  W/SHIELD WIPER MOTOR TO RELAY
892 W/SHIELD WIPER SW. TO RELAY
893 W/SHIELD WIPER MOTOR TO RELAY
895 IGN. SW. TO W/SHIELD WIPER MOTOR CIRCUIT BREAKER
896 IGN. SW. COIL TERM. TO IND. LAMPS, OIL PRESS. &
WATER TEMP.
897 CONTROL RELAY TO THERMAL RELAY
898 BRAKE SWITCH TO VACUUM SWITCH
899 ALTERNATOR NEU.-TERM. TO ALT. REG. (NEU.-TERM,)
900 ALTERNATOR AUX. TERM. TO IGN. SW. ACCY. TERM.
901 ALTERNATOR AUX. TERM. TO CHARGE IND. LAMP
902 ALTERNATOR RECTIFIER (+TERM.) TO LOAD
903 ALTERNATOR AUX. TERM. TO ALT. REG. FIELD FEED TERM.
904  (COIL/ACCY.)- TERM. OF IGN. SW. TO ALT. REG.
(IGN. TERM.)
905 AIR COND. SW. “MED.” TO BLOWER MOTOR
906 IGN. SW. (ACCY. TERM.) TO CIRCUIT BREAKER
907 HOLDING RELAY TO 25 MPH SW.
908 STARTING MOTOR RELAY TO LOCK IN COIL

Q7=

sBRAKE SWITCH TO AIR VALVE

% E PANEL (ACCY. FEED) TO SPEED REGULATOR SWITCH
‘AT T TS o ECTOR SWITCH

COLOR

WHITE-BLUE STRIPE
BLACK-YELLOW STRIPE
ORANGE

BLACK

BLACK

RED

RED-BROWN STRIPE
GREEN-YELLOW STRIPE
BLACK-WHITE STRIPE
RED-WHITE STRIPE
RED-BLUE STRIPE
WHITE-BLACK STRIPE
YELLOW

WHITE

GREEN

BLACK-ORANGE STRIPE
BLACK-RED STRIPE
GRAY

WHITE

ORANGE

YELLOW

WHITE

BLUE

RED

RED

GREEN

YELLOW
YELLOW-BLACK STRIPE
BLUE

BLUE-ORANGE STRIPE
RED

BLACK

RED

GREEN

RED

RED-GREEN STRIPE
YELLOW-BLACK STRIPE
BLACK-YELLOW STRIPE
GREEN-RED STRIPE

GREEN-RED STRIPE
BLUE

BLACK-YELLOW STRIPE
BLACK-ORANGE STRIPE
YELLOW

BLUE-WHITE STRIPE
ORANGE-WHITE STRIPE
YELLOW

YELLOW

GREEN

BLACK-ORANGE STRIPE
RED

GREEN

CIRCUIT DESCRIPTION

919 TRANS. NEUTRAL SW. TO INDICATOR LAMP

920 BRAKE SW. TO SPEED CONTROL REG.

921 SPEED CONTROL “OFF POSITION” TO SPEED REGULATOR

922 SPEED CONTROL ““ON POSITION"” TO SPEED REGULATOR

923 SPEED CONTROL SW. TO SPEED REG. SOLENOID

924 HOLDING RELAY TO SPEED CONTROL SW. FEED

925 SPEED CONTROL SW. TO SPEED REG. COUPLING COIL

926 HEATER BLOWER MOTOR SW. TO BLOWER MOTOR MED.

931 SPEED CONTROL SWITCH TO SPEED REG.

932 IGN. SWITCH TO THROTTLE SOLENOID

933 EMISSION MODULATOR CONTROL FEED

934 EMISSION SPEED SENSOR TO MODULATOR CONTROL

935 TRANSISTOR BASE TERM. TO DIST. TERM. OF IGN. COIL

936 TRANSISTOR EMITTER TERM. TO TRANSISTOR TERM. OF
IGN. COIL

937 EMISSION SPEED SENSOR GROUND

939 MODULATOR TO THERMO SWITCH

941 WASHER CONTROL SW. TO WASHER PUMP MOTOR FEED

943 TRACTOR TRAILER RELAY “B” TERM. TO TRACTOR TRAILER
CIRC. BRKER. LOAD TERM.

948 FLASHER TO R. H. LAMP

949 FLASHER TO L. H. LAMP

950 FUSE PANEL TO WASHER CONTROL SWITCH

951 WASHER CONTROL SW. TO WASHER PUMP MOTOR FEED

952 BATTERY TO TRACTOR TRAILER CIRC. BREAKER BATT. TERM.

953 COORDINATOR SW. TO W/SHIELD WIPER MOTOR

954  W/SHIELD WIPER SW. TO COORDINATOR SW. FEED

956  W/SHIELD WIPER MOTOR ARM RH TO W/S WIPER SWITCH

956 W/SHIELD WIPER SW. TO W/SHIELD WIPER MOTOR FIELD RH

957  W/SHIELD WIPER SWITCH FEED TO IGN. SWITCH

958 ACCY. TERMINAL IGN. SW. TO WASHER CONTROL SW.

960 AUX.HEATER FEED TO SWITCH

961 GLOW PLUG SW. TO GLOW PLUG WARNING LAMP

962 DIFF. TEMP. SW. TO FRONT DIFFERENTIAL

963 DIFF. TEMP. TO REAR DIFFERENTIAL

964 ALT. TO REG. FIELD CONTROL

965 RELAY (BATT. TERM.) TO BATT. CUT-OFF SWITCH

973 BATTERY FEED TO FUEL CONTROL VALVE

974 FUEL CONTROL SWITCH TO FUEL CONTROL VALVE

975 TRANSMISSION TEMPERATURE LAMP INDICATOR FEED

976  FUSE PANEL TO FUEL GAGE INDICATOR

977 BRAKE WARNING SWITCH TO INDICATOR LAMP

984 MARKER LAMP SWITCH TO MARKER LAMP

985 TURN SIGNAL RELAY TO LEFT TURN SIGNAL SWITCH

986 TURN SIGNAL RELAY TO RIGHT TURN SIGNAL SWITCH

987 TURN SIGNAL RELAY TO LEFT TURN CANCEL SWITCH

988 TURN SIGNAL RELAY TO RIGHT TURN CANCEL SWITCH

990 RELAY TO INDICATOR LAMP

993 INTERMITTENT GOVERNOR TO WINDSHIELD WIPER SWITCH

994 ELECTRIC COOLING P.V.S. SWITCH

995 HEADLAMP SWITCH TO LO-BEAM OF HEADLAMP

996 HEADLAMP SWITCH TO WORKLAMP

997 IMPLEMENT LAMP SW. TO IMPLEMENT LAMP

998 HEADLAMP SWITCH TO HI-BEAM OF HEADLAMP

COLOR

BLUE

YELLOW
GREEN-VIOLET STRIPE
WHITE

VIOLET

RED

WHITE-ORANGE STRIPE
RED-BLUE STRIPE
BLACK

BLUE

RED

BLUE

BLUE

BLACK
BLACK
GRAY
BLACK-WHITE STRIPE

GREEN

ORANGE

BLUE

WHITE-BLACK STRIPE
GREEN-BLACK STRIPE
YELLOW-BLUE STRIPE
WHITE-ORANGE STRIPE
BLACK-WHITE STRIPE
RED-ORANGE STRIPE
GREEN-ORANGE STRIPE
YELLOW

WHITE

RED

BLACK-WHITE STRIPE
RED

GREEN

BLUE

BLACK

RED

ORANGE

RED-GREEN STRIPE
BLACK-GREEN STRIPE
VIOLET-WHITE STRIPE
BROWN

RED

BROWN

RED-BLUE STRIPE
BROWN-BLUE STRIPE
BLACK-YELLOW STRIPE
BROWN-WHITE STRIPE
YELLOW

RED-BLACK STRIPE
YELLOW-BLACK STRIPE
BROWN-YELLOW STRIPE
GREEN-BLACK STRIPE
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. 33 v 33 ¥ —4 HBRN, HORN RELAY,
35 152 v 152 Y —4 REFERENCE @NLY SEE CHARGE START RUN,
Y [ 37 BK-Y 37 BK-Y =S REFERENCE @NLY SEE CHARGE START RUN.
152
A $ ¥ c-206 383 R-W 4 EXTERI@R LIGHTING, EMERGENCY WARNING FLASHER
| .
=38 BK-R —FUSE LINK -1—39 BK-R == Yo
' 5-201
C-207 7 " A? c-21
) Py ! 37 BK-Y
|+ STARTER g;,—-———* BKRe
= meTeRr ‘--«
= {12 veLT RELAY 284 R 284 R —4 REFERENCE @NLY SEE EXTERIOR LIGHTING,
] FUSE PANEL LBCATED IN GLOVE BBX — |BATTERY e
®N R.H. SIDE OF DASH PANEL = § 19 BL-R
— I
F-1 120 ANP) HERTER ;J; €-205 A F-3 19 BL-R S TLLUNINATION LAMPS. 5-301.
F-2 (14 ANP) BACK UP LAMP . RADID C-208 | (2 AnP)
— . g - 40 BL-H =& REFERENCE BNLY SEE PR@TECTI@N & CONVENIENCE.
TURN SIGNAL & WIND SHIELD WASHER 37 40 BL-H 8 F
F-3 (2 AMP) INSTRUMENT PANEL ILLUM
BK
C F-4 (15 ANP) DOME LAMP & CIGAR LIGHTER l 21 ¥ To0p
F-5 (20 AMP) EMERGENCY WARNING & 6-202 1 c-240 AMHETER
ST@P LAMPS = 37 ——285 BR 285 BR —%
B ar 54 ——285 BR 285 BR —5 > REFERENCE @NLY SEE EXTERIOR LIGHTING.
] — 45 R-y 15 R-Y —
TGNITION Bk 15
SWITCH
SHITCH
0 POSITIBNS 21 v
S-START
R-RUN
8-0FF
A-ACCY
———30 BK-GR 30 BK-GR —% REFERENCE ONLY SEE CHARGE START RUN,
] (763 84 763 B-W —% WINDSHIELD WIPER WASHER, WINDSHIELD WIPER &
BK-GR | RO ‘ WASHER SWITCH,
HEADLAMP d¥£-297 BK-GR § B-y —————————% EXTERIOR LIGHTING, TURN SIGNAL FLASHER,
€ SHITCH 5-202 137 ¥-BK —————% RADI8. AM RACIO,
140 BK-R ——————& EXTERIBR LIGHTING, BACKUP LAMP SWITCH,
, F-2 8 8-y 950 W-BK ——=————% WINDSHIELD WIPER/WASHER . WINDSHIELD WIPER &
820t (14 AMP) 5-302 WASHER SWITCH,
] F-lJL}ftP 399 BR = HEATER. HEATER BLBWER SHITCH.
(20 AMP)
F 297 BK-GR
1 | 2 [ 3 I 4 [ 5 [ 6 I 7 [ 8 I 3 I 10 T i1 l 12 I 13 T 14 T 15 T 1e
c-205 C-211 C-408
14401
14401 14401 14401 284 R
38 BK-R —O) @37 BK-V ©Cr33 v ——54 GR-Y
14305 40 BL-W
REAR OF INSTRUMENT CLUSTER « @138 B A
285 BR
14300 . 285 BR
C-206 @r=-re0 19 BL-R
s STARTER MBT@R RELAY 15 R-y
14305 14401 R.H. FENDER APRON 53 BK-BL
37 BK-Y 37 BK-Y L——53 BK-BL
oty 804 GR-R | == SHEADLANP SWITCH
38 BK-R BEWIND INSTRUMENT PANEL
BROWN 14401 RIGHT OF STEERING COLUMN
R.H. FENDER APRON 4 GR-R
NEAR ALTERNATBR REGULATOR 32 R-BL
32 R-BL
. 16 R-GR
C-207 21 ¥ GRBUND CBDES
» IGNITIBN SWITCH 6-202 @N ENGINE BLBCK NEAR ALTERNATOR
14300 BEHIND INSTRUMENT PANEL
RIGHT @F STEERING COLUMN
s EQ-RED
s BATTERY
POSITIVE TERMINAL @F BATTERY |[C-241 SPLICE C@DES
13927 §-201 IN 14305 NEAR STARTER MBT@R RELAY
§-202 IN 14401 NEAR TAKE@UT T@ IGNITI@N SWITCH
¢-208 ©r=-296 # $-204 IN 14401 NEAR TAKE@UT T@ IGNITION SKITCH
. 1440% $-302 IN 14401 AT TAKE@UT T@ HEADLAMP SWITCH
14301 :
(Cr3-297 BK-GR ELECTRICAL SYSTEMS 1976 BRONC®
* £01-BLACK LeNTTION SHITCH POKER DISTRIBUTI®N
» BATTERY . EFFECTIVE P.C.R
BEHIND INSTRUMENT PANEL eveme
NEGATIVE TERMINAL OF BATTERY B D N RN G FaLuHN SUPERSEDES
DATE 7/28/75 BEPE ELECT INST MAN PAGE E6T-900-1
SERVICE AND TRAINING MAN PAGE 1
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1 | | 3 | 4 I 5 | | ? | 8 | 9 | 10 | 11 12 | 13 | 14 | 15 i 16
prmamameme 37 BK - Y 37 BK-Y 37 BK-Y 37 BK-Y =t EXTERIOR LIGHTING, SPLICE S-601.
G138 BK-R® —FUSE LINK - 38 BK-Rm — 152 Y =————% CHARGE START RUN, ALTERNAT@R REGULATER,
! $-111 5-112 38 BK-R® ——& CHARGE START RUN, ALTERNATOR,
¢n;::::::3e BK-RS —FUSE LINK AT , 37 BK-Y =————t EXTERI®R LIGHTING, TRAILER EXT, LAMPS RELAY.
| 22 BL-BK =FUSE LINK NETE 22 BL-BK ~———=b EXTERIOR LIGHTING, ELECTRIC BRAKE CONTREL
(ron£ Q,a£~ ()‘\ —198 BK ~—@===198 BK —FUSE LINK =—O-- 494 R-W 491 R-W ===t PROTECTION & CONVENIENCE ,RBOF LAMP RELAY,
(e} $-107 £-232 1C.B.(20 ANP) $-110
. v 883 9 FUSE LINK -0 883 0 4 AIR CBND & HERTER., BLEWER MBTBR RELAY.
QO ;‘qub”‘ I 38 BK-RW =FUSE LIN5~’—”’,,— . 4 36 BK-R® 655 R-@M ==& CHARGE START RUN, PRINTED CIRCUIT.
ol D €212 Qremmmmmnty GAGES BNLY §-104 $-10%5 152 Y ammmmm—mt, CHARGE START RUN, ALTERNATBR REGULATER.
—Qy/ 0 QO | &-----1 €-233 38 BK-R 38 BK-R® ~—————4b CHARGE START RUN, ALTERNARTOR,
USSR RED 9 37 3y [37 BK-Y 37 BK-v §54 Y-BKS ==t CHARGE START RUN, PRINTED CIRCUIT,
4D, YO~ o BKSY By Y Y37 BK-Y $-106
o - . g Fuse  FUSE 33 ¥ < HORN & SPEED CONTROL, HORN RELAY.
,/CL/??: :beox\\ ——g | [STARTER LINK  LINK 19 BL-R 19 BL-R ——=% ILLUMINATION LAMPS,HD/LP & IGN. SHITCH,
o 2| ineter Fog (3 ERPT LY BL-R —— ILLUMINATION LAMPS, RAUIG,
0O 1€Uf? 12 voLt RELAY $-101 @ S-10% L GAGES 54 GR-Y 54 GR-Y ==t PROTECTIBN & CONVENIENCE, CIGAR LIGHTER @R
\ 1 , BATTERY J(/,,—-—-—-—-—-- DOOR JAMB SWITCH @R INTERIGR LAMP SWITCH
FUSE 3 3 -
PANEL BK-Y  BK-Y -4il 54
1 GR-Y
C-207
M {HERDLAMP FBR ADDITI@NAL H/D,LP.SW.CIRCUITRY
SWITCH SEE EXTERIOR LIGHTING PG.5S
33 ¢ PROTECTION & CONVENIENCE PG.8
BK 37 Y
BK-Y
C-411
§-102 3 BK-BL ——————% PROTECTION & CONVENIENCE, DOME & CARGE LAMP @R DBBR JAMB SWITCH @R INTERIOR LAMP SWITCH
ﬂff Q 6-101 285 BR ——————% EXTERI@R LIGHTING, SPLICE-503
F-1 (30 AMP) HERTER - 21 15 R-Y 4 EXTERI@R LIGHTING, HD/LP DIMMER S,
Y et 37 BK - ¥ 54 GR-Y =
F-2 (3 ANP) INSTRUMENT PANEL & | 297 BK-GR ——— F=9 (15 AMP)
CLUSTER ILLUMINARTION /L 7[ 7 - 383 R-W = EXTERIBR LIGHTING., EMERGENCY WARNING FLASHER,
37 — F 8120 AMP:
F-3 (7.5 AMP) THRBTTLE S@LEN®ID BK-Y t-302 1<——7r g0 65 GR — WINDSHIELD/WIPER & WASHER . W/WPR M@TOR
[ 85 GR - WINDSHIELD/WIPER & WASHER, W/WPR SWITCH
- (7.5 AMP)
F-4 (7.5 AMP) SERT BELT HARNING “\J 8 a-v ~4 EXTERIOR LIGHTING, TURN SIGNAL FLASHER.
. 140 BK-R —=————— EXTERIBR LIGHTING, BACK UP LAMP SWITCH,
F-5 (BLANK) s F-11 (15 AMP)
: 181 8 — AIR CONDITI@NER & HEATER, HEATER BLOWER SWITCH.
F-6 (7.5 AMP)  WINDSHIELD WIPER SYSTEM o D--©O -237 :Kf—q F-1 (30 AMP)
c-208 | > = 297 BK-GR ! 137 Y-BK ~—————& RADIO, RADIB,PG,9-A3
F-7 (BLANK) T €-237 : F-12 (7.5 ANP) 297 BK-GR 297 BK-GR ——= CHARGE START RUN, PRINTED CIRCUIT,
_l_ IGNITION | ™ 30 BK-GR —=— CHARGE START RUN, RADI® SUPPRESSION CHOKE,
F-B (20 AMP) EMERGENCY WARNING = SHITCH [ > S=—=297 BK-GR
— |12 veLT p : c-302 F-10 (& 296 R =—————% HBRN & SPEED CONTROL , SPEED SENSOR SWITCH
F-9 (15 AMPI COURTESY LAMPS = |BaTTERY S SITCH | 1 * 297 (20 AMP) !
= |tRUXILIARY) L POSITIONS | BK-GR 297 BK-GR 297 BK-GR <{§;Zf§}-297 BK-GR — S HORN & SPEED CONTROL. SPEED C@NTR@L AMPLIFIER
F-10 (20 GMP) ACCESS@RY FEED ]2_ S-START : c-719 |
v R-RUN O ké_______] IN-LINE
. . A 0-0FF ! FUSE
F-11 (15 AMP) BACK-UP LAMPS & TURN ' c-207 atatey Ve 5-103 297 BK-GR (s e
SIGNAL FLASHER R 640 R-Y ———=% CHARGE-START-RUN, THRBTTLE ACTUATBR
BK 2 640 R-Y 932 BL ~ CHARGE START RUN, EMISSI@N CONTREL SOLENOID,
F-12 (7.5 AMP) RADIO x& ' F-3 (7.5 AMP)
Q 6-101 584 GR-BL = —~4 SEAT BELT WARNING
F-4 (7,5 AMP)
1 I I 3 [ 4 [ 5 I 7 [ 8 l 9 I 10 T 11 12 | 13 I 14 I 15 l 16
C-206 €-232 C-302 .
14401
14300
134709
s EQHRED . 98 BK
491 R-H .
POSITIVE TERMINAL BF BATTERY . G{T‘ 297 BK-6R
» BATTERY . 32 R-BL
R.H. FENDER APREN b0 Ren
€-207 w CIRCUIT BREAKER (20 AMP.) gé?Vp_“.
14301 BRAY
s E01-BLACK L.H. SIDE @F
NEGATIVE TERMINAL @F BATTERY [ C-233 INST, PANEL
» BATTERY L4401 14305 aIGNITION SHITCH GROUND CODES
L 37 BK-Y 11 6-101 EYELET ATTACHED T@ R.H.SIDE ENGINE BLOCK
€-212 37 BK-Y 37 BK-Y 14401
. 37 BK-Y 37 BK-Y 54 GR-Y
14305 25 BK-0
(C1-38 BK-Re . 54 GR-Y
285 BR SPLICE CBDES
14300 15 R-Y
©C1-rReD C-237 19 BL-R $-101 IN 14401 NEAR STARTING M@T@R RELAY
53 BK-BL 5-102 IN 14401 NEAR T/@ T@ EMERGENCY WARNING FLASHER
14 4 -
o on 11030 I e
37 BK-Y R CRASH PA B
i {137 Br-v UNDER CRASH PAD $-105 IN 14305 NEAR T/8 T8 STARTING MBT@R RELAY
38 BK-Rs 8 HEADLAMP SKITCH
. 0t 144303 5-108 IN 14305 NEAR 1/8 T@ 14401 ASSY
14401 5-107 IN 140303 NEAR STARTING MBT@R RELAY
@137 BKk-v C1F-198 B« ERLEL PP 5-108 IN 142303 @R 140346 NEAR STARTING M@TOR RELAY
. 14300 $-109 IN 140303 BR 140346 NEAR STARTING MOT@R RELAY
140303 296 R ——) $-110 IN 14R480 NEAR STARTING MBT@R RELAY
‘&> 14401
(11198 BK RED 30840 5-111 IN 14305 NEAR STARTING M@T@R RELAY
140303 30 BK-GR §-112 IN 14305 NEAR T/@ T8 STARTER M@T@R RELAY
140480 297 BK-GR—®) 297 BK-GR
©1—1297 BK-6R ELECTRICAL SYSTEMS 1976 ECON@LINE
(Ctr-883 @ ACCESSBRY SAFETY RELA 144303 POWER DISTRIBUTION
R.H. FENDER APREN ELaY 297 BK-GR—®) EFFECTIVE P.C.R.
NEAR ACCESSBRY SAFETY RELAY SUPERSEDES
NEAR IGNITION SWIT
& STARTER MOTOR RELAY TGNITION SWITCH DATE 8-4-75 BEPE ELECT INST MAN PAGE E6U-900-1

SERVICE AND TRAINING MAN PAGE 1
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- 1 | 2 | 3 | 4 | 5 | 6 | ? | 8 ] 9 | 10 | 11 | 12 | 13 | 14 | 15 | 18
C- 1101 C— 883 @ C-1113
, POMER DISTRIBUTION. SPLICE S-110. ¢ 883 @ < 883 @ 19A885 190885
_ <883 0 ! PONER DISTRIBUTION, FUSE PANEL (F-21,PG.1-814 S——19 BL-R 387 BK 347 BK
POMER DISTRIBUTION., FUSE PANEL (F-1) 9181 0 1 IIII7N p-1102 348 GR-N® 348 GR-N®
: a C-1111 N 884 T a
J,A/o_] PONER DISTRIBUTION, FUSE PANEL (F-21,PG.1-B14 $—19 BL-R GREEN
\ 1 WINDOW
181 @ 181 a-\r T €-1102 ' |REGULATOR 19
_ 181 @ ___1 D el ot NEAR T/8 BLBWER MBTBR GRAUND
— I 181 @ >~ 181 @ 753 Y-R —I- I\ C-1118 A RELAY 19 BL-R - —
. c-239 884 ¥ ——— . .
— { J - 2 \ J A/C MODE SWITCH 134885
C-1103 )l 2 at?n
SKITCH T C-1102 /82070 T c-315 EVAPORATOR  [0]-348 GR-We
: PRSITIBNS AUX . ~ 7[\ 293 i o) (ELOWER MOBTOR RELAY 19 BL-R > > 19 BL-R , TERMBSTAT um
8 1. OFF asc > r, 3 o 753 ~ 8
B 131 2. 10 %f/é % CONTRRL -—o\\J> v-R 753 900 Y-R (’ 5 C-901 SWITCH (B~ 247 B
. TCH . 1 19 A
3. :gg ; 2?3?‘? xs:LIa:sm ———)>———| C-1118 N BL-R BL-R 8L-R (T D
S NN : ¥ C-1118 ) C-514 T R.H, SIDE BEWIND INST. PANEL
B ] . X C-1103 C-1102 Y A JERL oilr 19
- : v - - - -
T c-1107 269 . [ A ANICL ¥ C-513 | BL-R €-1115 . 194885
SHITCH 5 : . | c-301 |
POSTT NS HEATER o288, 269| RS NINDOH 753 Y-R 4 66 B ——y) l l AK l STEREQ TaPE/ Bk @ ©-347 B¢
— 2: LBu BLOWER BL REGULATER €-1116 BE?R BE-R 19 bt Bt?R RADIG RADIA NEAR A/C CAMPRESS@R
C | 3l mep | R smrrew j AN SHITCH T BLoR RECEIVER RECETVER ¢ IN ENGINE CMPARTMENT
) —-A A ) . o
4. HI 1107 c-1104 C-1104 o auER NBTOR RELAY) L__.____“e 6R-H 8 —ed nsx;xeus g;fmm HDLP/IGN/ HEADL AP 16N SWITCH/ VEATER = = » PART @F A/C CLUTCH SBLENEID
- 268 269 c-1113 ; :E: Loul SHITCH N/S/H/HASHER SHLTCH W/S/W/WASHER I/p PRNDL CONTROLS —
2 R-BKs | B . 2?3?‘?13‘_0““ 3 ) centroLs TLLUNINATION 3 ) contreLs 3 )1LLUMINATION ILLUMINATION C-D TLLUMINATIEN F@R ADDITIBNAL RADI® CIRCUITRY t 198885
,,,,, — A 269 270 3, MED HI ILLUMINATION L ANP ILLUMINATION LAMP & Lanp Lanp SEE RADI@ SYSTEM PG, 9 —
Q288 T 270 BL BK-Y 348 4. HI Ll Co1116 LAMP LAMP g 270 BK-Y
~ e e et nr GR-He B¢ HEATER-A/C
|1 T Ol l ok sh BLOWER mm 269 8L
_e 245 270 C-1114 269 BL 57 57 57 e BK SWITCH 268 R-BKm
D T’f’r c-1108 BL BK-Y T 269 BL BK BK BK ) 269 BL
_ 268 | 269 EVAPORATER KoL l [0 B \ c-211 BEHIND A/C CONTROLS
270 R-BKa BL ) ‘g THERMBSTAT AN A AT c-1117 ML & C-513
BK-Y . __7L‘_ SWITCH /r T T L v J €-301 C-1117 19A885
| PR T R e (A/C CLUTCH) s c-514 -
- BLOHER \L 269 BL
HeTOR c-1114 WITHOUT KITH F 57 884 v
w AN L5 >— 34Y; Bk AIR COND, AIR COND, K 8K 268 £-BKS
C-1109 BK _ .
p BK BLOWER NETOR 57 8K ——b5 CHARGE, START, RUN, ArC 2270 Bk-¥
- £ N C-1113 RESISTER 57 8K ENGINE SPEED SENSOR PG.4-F15 3 BLOWER 269 8L
BLOWER MeTeR AUXHTR, T BLBWER RE":IT:[RQR ™
RESISTOR oR ArC 347 NBTOR 57 BK 57 BK 57 BK ——% CHARGE START RUN, IGNITI@N =
5-20 SWITCH BACK PLATE PG.4-F2 o
— BK :‘6‘:::" BK 201 s PART @F BLOKER M@/ 2R
— J\ c-1115 B]K 57 BK —% HWINDSHIELD WIPER WASHER, — R.H. SIDE STEERING COLUMM
’r l 57 HINDSHIELD WIPER WASHER SWITCH, =115
! Bk C-1110 BK OR GOVERN@R PG.3-F15 190885
- BLOKER Y t-1110 | e A/C KITH @R T a/c 753 v-R
F 57 HITHBUT AUX.HTR, 57 F MODE s 753 Y-R
MeTeRr 3 CLUTCH Bx
£ SBLENBID B 6-203 SKITCH 181 @
é A & 4L - 348 GR-W®
- - Q 6-201 Q 6-202
"""" R.H. SIDE STEERING COLUM
1 | 2 [ 3 I 4 [ 5 I 6 [ 7 | 8 ; 3 [ 10 [ 11 i ) I 3 T T3 T TS I e DE STEERING COLUMN
— C-315 c-1101 C-301 C-514 C-1103 C-1106 C-1110 C-1111
138743 19949
19A885 57 BK 188604 269 BL
B8R 190885 194885 @R
L 883 @ 14401 19 BL-R 268 R-BKm 19949
883 @ 57 B GREEN 14401 AUXTLIARY 270 BK-Y AUXILIARY 270 BK-Y 188604
. - 269 BL BLOKWER 269 BL OR 134885
19 BL-R 57 BK A/C-HEATER . 14401 81 @
283 v-BK BREWN 144480 39 R g0 oy 138743 19 BL-R FaN . 269 BL MTOR . . 181 8]
. 385 W-R 883 0 DL ML 904 GR-R 57 BK 19 BL-R SHITCH 2o8 5o RESISTOR sk EKJEA'] [cL?_rF—sr BK 19198510‘0
19 BL-R 188604 . 1 297 BK-GR 57 BK GREEN ®s PART OF BLOWER MOTOR BROWN BROWN 753
1 BL-Y BROKN ST e 3 BRW 19 BL-R
282 GR 883 @ Hs77 P 48 BK 19 BL-R NEAR T/ MODE CONTROL SHITCH == R.H. SIDE UNDER I/P
- 2 W-BLe GREY Hea0 Ry S0 BK-GR GREEN GRAY
3 GR-N 14401 BROWN 188604 » PART BF BLOWER MOTOR
810 R-BK 283 ¥-BK 286 8 L.H. SIDE 8F STEERING COLUMN 270 BX-y NEAR T/@ A/C MODE CONTROL SWITCH
L] . - 4 -
44 BL 385 H-R NEAR T/8 HTR & A/C BLWR MTR RELAY sRAY €-110 HEATER
_ 19 BL-R BLOWER ® 269 BL
19 BL-R BEHIND INSTRUMENT CLUSTER ¢-301 190605 or igg:g; SWITCH 181 @
1 BL-Y = » PRINTED CIRCUIT (W/@ GAGES) . 14401 268 R-BKN
c -
287 oR 211 C-239 270 BK-Y 270 BK-y GROUND CBOES
v 94840 GREY 2 u-BLe 19 BL-R iy ok 269 BL 269 BL BEHIND HEATER CONTROLS §-201 NEAR BLOWER M@TOR
- 283 v-BK 3 GR-N 14401 . t x:g! 19?“' 268 R-BK® 268 R-BKm IN 19949
385 W-R 3 GR-H - 137 v-8 137 ¥-BK C-1108 6-202 NEAR BLBWER M@T@R
19 BL-R 2 H-BLe B 031 W-Re =13 UNDER I/P, REAR @F RADIG 130803 188604 188604 IN 19885
; 810 R-BK ® 0H—0977 P-us " PART BF RADIO B8R 134885 6-203 R.H. SIDE BEWIND INST. PANEL
— 1 BL-Y 44 BL BLAWER 263 BL IN 14401
282 6R : &’“g;g :“’ 188604 188604 269 BL 269 BL WoTBR ua 268 R-BKm
3 en BReY » |® 030 Brar g0 BX 181 quj\['E}—im 0 \ e C-1102 RESISTOR OSEI SPLICE CODES
. 810 R-BK 0Or—3 8R-H__, i Bia BRAY 188604 : 5-201 IN 14401 NEAR T/@ T8 HD.LP.4 IGN.SH.ILLUM,
44 BL U 0r—655 R-0s . "." 19 BL-R 19 BL-R /e oR 190885  |[C-1105
NDER STEERING CO s S BK > B > B HERTER 753 Y-R
v NG COLUMN 31—13 BL-R Y- R.H. SIDE STEERING COLU.,
NEAR HTR& A/C CONTROLS BROWN BLEWER 834 19948 190605
® COLUMN WIRING L\ sray N NBTaR
o R.H. SIDE 87 STEERING COLUMN RELAY 883 o 269 BL 269 BL C-1109 ELECTRICAL SYSTEMS 13976 ECBNOLINE
REAR BF INSTRUMENT CLUSTER ®» PART @F HEATER CBNTROL 269 BL @zss BL 188604 . AIRCONDITIBNER AND/@R HEATER
268 R-BKa 268 R-BKw EFFECTIVE P.C.R, ILLUMINATION LAMPS
PRINT T
s PRINTED CIRCUIT (GAGES @NLY) 270 BK-Y 370 BK-Y 270 BK-Y Q) @-8K SUPERSEDES
— L.H. SIDE @F STEERING COLUNN » PART BF BL@WER MBTER DATE 8-4-75 BEPE ELECT INST MAN PAGE E6U-900-2
SERVICE AND TRAINING MAN PAGE 2
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1 | 2 3 | 4 5 | 6 ? | 8 9 | 10 11 | 12 13 | 14 15 | 16
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R & C-2054
§-201 €-302 s C-303 Bl CE T Y Tc—me Yc-409 ,r\c-we Yc-aos T Y
D --O——262 BR —O-- [0} -0~ v : , 26 35 26 35
|O/——d """"" (ﬁ BK-R ° BRR 'y bR Y BK-R é
STARTER | b 5 IO I 4 5 b
¢-s01 ® i €-2054 152 L L““Y——J L_“Y_—J L—"Y_—J L—‘—Y——J g
G—R =R —— rT = RELAY t-2054 ¢ ~-
. . —& b——32 R-8L —O-—-{O]-© 132 18 TRANSISTBRIZED @R CONVENTIBNAL REGULAT@E SYSTEM
| C-303 r——/‘&—j
6 vour [FE ‘—I—‘+s veLT 883 @ 1 L T { C-205 & 205A
BATTERY | —- — |BATTERY % 904 &R-R 504 &R-R ""I
—-[-“ T O——669 R-BL —O $—904 GR-R —O-—[O]—-O—904 GR-R —
—_— — Lo o— = . -
v v | . 128 8K - "4 l l 568 GR 904 GR R-—ﬁJ
C-306 AR A - €405 152 568 152 568 GR
T 3 R Y 08 ALTERNAT@R REGULAT@R
O———568 BK =——O 26 l
BK BK —0 BK-R C-407 /\::::: L——568 GR
O——113 Y-8k =0 [ = ————y —ao e~ b A >
$ (£ L\ e — AR T ALTERNATER 26 3
€-307 ? BK-R @
A . - R CONVENTI@NAL c-a06 [ o ~g | FIELD TRASISTORIZED
s 1- m— REGULATAR AAVA \ RELAY REGULATOR
6 veLr | = ——+s VoL — BK SYSTEM BK L4 5>——904 GR-R — SYSTEM
BATTERY | — = |BATTERY c-304 RaDIO g c-a07 C-408 T i
T T— N IGNITION ) N 35 8 A
Y Y © INTERFERENCE \L .
' ' & B 2 S T CaPACITER C-407
b—BK — BK - 26 STARTER MBT@R = = = C-408
C-302 B 6-203 6-204 o ® L—ze BK-R ——@—— 26 BK-R —é(————n BK-R
Q 6-210 6-4017  , 1ERNATOR REGULATBR §-402 26 BK-R— ¢ 401
1 [ 2 [ 3 [ 4 [ 5 [ 6 ] 7 [ 8 9 I 10 11 [ 12 | 13 T 14 I 15 [ 16
C-205 C-206 C-302 C-304 C-401 C-404 C-408 C-411
14305 14305
JUNCTIBN BLOCK 108942 11A003 14305 s 14398 G135 0
] 430 s | ===3 K-R
(198573) 8K ——TO)101(OT 3359 BK-K (13AB8S] @655 R-9 H301 @1~ 26 BK-® 37 BK-Y 268 568 &R ALTERNATER ® 14305
L R R
(94281 @R 143051596 BK ——T0)10}(CTI—536 BK (94342) AMMETER & RED BaTTERY 8 X ©{T-s68 5k Oy RED o I L varen FRONT e il G 1350
~ 8K
(9A281 BR 143051 597 R —TO){O1(CTI—597 R (3A342) 654 Y-BK o1 BaTTERY SY Fees r-sL 14305 26 BK-R 26 BK-R FORWARD L.H. SIDE @F ENGINE
(9281 BR 14305) 787 R-BR ——T0){01(CT 787 R-BR (9A342) YELLOW s 4 Bxoy C-405 A D“S:GP::;'L’ —
BEHIND CLUSTER 14 - 439 M. EL -
(146?428)24:[2_ sL’Y —CL__OS?PO‘ @[:}—482 BL-Y (14401 3 8 . 135 : IN ENGINE COMPARTMENT 14305
-y —T0) ©1F 113 v-8¢ RED .
L1azgp, 13 RTEK —CT0){0t(CT—13 R-BK (14401) T 303 5;::;:9 = 14305 ALTERNATOR 904 GR-R a ALTERNATBR REGULATIR ALTERNATER ® gg ::_:
12 6R-BK —T[0)101(CT 12 GR-BK (14401} t-207 D1 128 8¢ S92 8-y REGULATER :gg y FORWARD L.H. SIDE @F ENGINE
(14290) 11 Bk-Y ——T0)10+(CT—11 BK-Y (14401) 14401 108942 14398 14301 14305 C-409
L 655 R-0 655 R- - IN ENGINE CBMPARTMENT, R.H,
55 R-@ 37 BK-Y @Io—37 BK-v
FOR CBNTINUATION SEE C-205A 654 V-BK 54 ¥-BK 655 R-8 18« SIDE @F DASH PANEL 14305 14398
IN ENGINE COMPARTMENT. BN L.H. SIDE OF DASH 1398‘5‘: ig :;“R Cro-152 ¥ G}« ON ENGINE, L.H. SIDE, FRONT jm——m 26 BK-R gg:u BK-R GRBUND CBDES
o ©1=—32 R-8L ® ALTERNATOR i 350 359
31 W-R 31 W-R 14300 14398 6-201 IN 14301, AT FRAME SIDEMEMBER AT BATT TRAY
T IT) 30 BK-GR 30 BK-GR (Or=1262 B8 G F* . ©-152 v™ IN ENGINE COMPARTMENT. R.H, 6-203 IN 14303, ATTACHED T8 ENGINE BLOCK
286 @ 286 @ T ® 4398 SIDE @F DASH PANEL. NEAR §-204 IN 14303, ATTACHED T@ DASH PANEL
JUNCTION BLOCK S0 GR-H 50 GR-W 118103 , 402 BK 14398 STARTER MOTER RELAY 6-210 6-210 IN 11A003 ATTACHED T@ DASH PANEL GRBUND
N 14401 37 BK 57 8K @r-669 R-BL LOWER R. BR L.H. SIDE BF ENGINE 14305 ©-368 6r 6-401 IN 14398, AT ALT. REGULATBR MOUNTING SCRENW
34 GR-BK 34 GR-BK STARTER (573669 BK G126 BK-R R.H. SIDE @F DASH PANEL, ON 6-402 IN 14305, AT ALTERNATER MOUNTING BRACKET
(14398) 904 GR-R -qj@.o--@:,—gm GR-R 49 W-8L 49 W-BL METOR ® C-306 ALTERNATER ® 14305 ALTERNATOR REGULATER C-410 6-404 IN 14305 ATTACHED T8 DASH PNL.GROUND
(14398) 37 BK-Y _C©>o-r 37 BK-Y NATURAL ReLay  (OT3—32 R-BL Gr-26 BK-® s NBISE SUPP, CAPACITOR
(14305) 37 GBSKS"R‘;U@ 654 ¥ B BEHIND INSTRUMENT CLUSTER G137 Bk 14304 ws CONVENTIBNAL IGNITION 14303 SPLICE CBOES
! -0—10)10yB12-655 -0 ' BATTERY & EQI-BK FORWARD L.H. SIDE @F ENGINE $-402 IN 14398, NEAR TAKE@UT T8 ALTERNATBR REGULATER
14305 mes TRANSIST@RIZED IGNITION 359 ’
(9£724 BR 14398 32 R-BL —{—T0)101(CT3-32 R-8L G113 v-Bx a1 BATTERY
(9£306 @R 14305) 69 R-GR —Cx@’}—-o«@j—ss R-GR c-301 : bK
(12336) 853 R-6R —TO0)— G128 Bk C-403 EE80 ’
(14305) 16 R-6R ——L0){01(CT-16 R-6R 14300 190885 c-307 14398 . 14305
-+ 14305 152 ¥ @ 135 ELECTRICAL SYSTENS 1976 L-SER (CITv DEL)
(14398) 262 BR —CTO) sariey 8 07 (@883 o 14304 ALTERNATOR %35 ° “L‘F""‘E‘" . 568 GR CHARGE . START. RUN
1EL - » LoH, .
FOR CONTINUATI@N SEE C-205 R R.H. SIDE OF ENGINE COMPARTMENT BATTERY » EO}-BK ORANGE e 26 aan @N ENGINE, L.H. SIDE. FRONT EF:E:%;ESP'C'R'
IN ENGINE CEMPARTNENT, BN DASH PANEL. L.h. SIDE AT BATTERY Al BATTERY R.H. SIDE BF ENGINE 904 GR-R ® ALTERNATOR SarE io 30-75 IRP@ ELECT INST NAN PAGE E6H-900-5
R.H, SIDE OF ENGINE C@MPARTMENT SERVICE AND TRAINING MAN PAGE  a—
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C-s4 ¢-707 90350
42 FUEL
CONNECTBR C-521 CHGE.START,RUN- PG.4-C13 =537 R 397 R 1239”,“ PUNP & (©I-57 8K
CONNECTOR C-521 CHGE.START.RUN- PG.4-C13 =598 R-BR 399 R-0R FUEL £0 BK-H NaTeR
TeR C- HGE ,START,RUN- PG.7-A7 =599 R-BL
| commector c-s2i chae sTaRT uRUN | 38 A sauGE " 286 o BN L.H. FUEL TANK
CONNECTBR C-521 POWER DSTR.- PG.1-A1l 969 R-GR O §9 R-GR 599 597
- RA .
BALLAST RESISTOR CHGE.START,RUN- PG.4-C6 =853 R-GR R ~0--{5}-©0 k-t R BEHIND Fubl ot e ¢-708 90350
c-205 4 c-20%a (O O——286 9 l FUEL
SPLICE S-504 POWER DSTR.- PG.1-E12 9=30 BK-GR 286 @ o -fo]--o =R 204 | _ npeur"apn » ©1I357 8k
— SPLICE S-503 POWER DSTR,- PG.1-Bi1 =21 Y C-624 O——286 @ =787 R-BR T TF : c-51%
SPLICE §5-502 POWER DSTR.- PG.1-Di1 =16 R-GR \ [——* ) P”"'; olL 108342 BN R.H. FUEL TANK
CONNECTOR C-521 CHGE,START,RUN- PG.7-A8 9599 R-BL ——————— TRANSISTORIZED c-704 RITT ] H:NUM PRESSURE @360 BKk-#
SPLICE S-504 POWER DSIR.- PG,1-E12 =297 BK-GR =——— 16N1T10N T ranTRoL s SAUGE B3t Wk c-709 9n281 08
. CONNECTOR C-503 CHGE,START,RUN- PG,7-E4 9—977 P-W —— c-207 aNLY ﬁﬁf,: { P ’ c-:os 8 BEMIND OIL PRESSURE GAVGE f»vﬁt 14305
y
CONNECTOR C-521 POMER DSTR,- PG,1-A11 9=896 sx-j T SELECTOR | /=" ML @c-zosa L S @3:;; :x i
o TI c-s10 30 SHITCH 99 596 C-318 08942 PRESSURE et
f 896 ¥ ™7 BK-GR Ll ) BK ! SWITCH
] c-508 c-307 v ¢-701 T: = -~ 537 - C/¥ UNIT @ A FRENT @F ENGINE
60 BK-H §0 BK-W 673 GR I T 48 c-20% 596 R — —
o o : o0 Bxon 675 GR-R g} o A oK i BEHIND 1/P CLUSTER =15 »
WATER : + L 672 BR l C-20%4 k;: C-709 FUEL 50
OIL PRESSURE TENPERATURE . rY €-512 C-513 €-515 C-514 T T c-517 Pume ®» (O3-672 B8R
] WARNING ARNING A ! INSTRUNENT ‘,..J\.W FUEL T c WATER 14303 MeTer
INDICATOR INDICATOR o : CLUSTER (—A_W T PUMP TEMPERATURE 8 (G139 R-# 18P @F L.H., FUEL TANK
LAKP LaNP b O |1GNITION VoL TAGE 679 675 T 48 8K oIL SENDER L _
o 8 O L REGULATOR C-513 L waTeR  C-3130gr  C-314 [hoe o GR-R 48 8K — PR ren FRONT @F HANIFOLD c-7id 34350
| —T LC/v UNIT) TENPERATURE PRESSURE GAUGE 67 674 SWITCH 1 FUEL
—_ A P ‘ SHITCH Ve 516 GAUGE BAUGE BR BR-H C-709 — C.519 PuMP » (O3-674 BR-W
¢-50% C-%0? o O | |PeSITIONS s? 8 Y an HRTaR
T ¥ 01 5-sTaRT 37 & 1 3 3 286 286 o) Q $ $ > e olL teras T@P OF R.H, FUEL TANK
b ] R N B R-W W-R e 0 , , , T -/ R-BR PRESSURE 8 (531 W-R WHe
W Y-R 71 BK —>>-977 P-W <+ : ::Egv 57 l c-626 [ t-626 [ c-626 [Q] c-626 [Q] é SENDER =55
0 c 508 : B« ; | | | | CIRCUIT 48 TERMINATES ety | 0 FRENT 8F L.H. VALVE COVER FUEL 94350
c-221 c-221 : T €-207 T €-207 C-207 53 ? IN HARNESS. ~ 4787 R-BR O-—{&] c-z‘os PuMe 787 R-8R
i I ' , . c-704 MeTeR
O - - €-207 §73 675 672 674 787 €-205A
G- o v 1 (IR ) - S < S e e oy o a5 sue 1o
— €54 $ $ I\ L mecwanIcaL FUEL PuRPS. ¢ - 787 k-8R
C-506 v C-508 57 f_A‘W C-705 | c-706 | c-710 0 c-711 | 674 BR-W
. B | | e Q @) c-626 675 GR-R
olL O  |wATER 57 8K Bc-221 Blc-221 FUEL FUEL ELECTRIC ELECTRIC 286 l 286 @
PRESSURE TENPERATURE $-505 l c GAUGE GAUGE FUEL PUMP FUEL PUMP ? 673 GR
£ SWITCH D CISKITCH ? 8 69 SENDER SENDER MBTOR MBTOR .47 £ FUEL 672 BR
= = Q ) R-gR O O v v R-BR TANK 9n342 VU0
52 57 = 39 31 C-705 C-708 ! ! SELECTOR "
Bk Bx ) R-H W-R I I A —A—  C-707 c-708 48 Bk
37 6-502 1 PC-305 c-305 T f c-202 ] 7]{ c-712 SWITCH 43 8K
— c-517 c-519 FUEL TANK FUEL TANK || 57 e 37 BK Q — g;: :"’“
ot o1 aLvE awo TR S SR A o FUEL punp 673 o8
MARKER LP,SW,ILLUM,LF, ILLUMINATI@N LAMPS- PG.3-B10 %—57 BK L BK
e s e 1 NorCaTeR PRESSURE T SOLENRID $SOLENRID Uﬁfb = SENDER HeToR BEMIND 1/P. R.h, SIDE OF CLUSTER
CIGAR LIGHTER,- PROTECT.§ COBNVENIENCE- PG.10-C12 997 BK SENDER SENDER ) i " c-202 7 Y703 F #8 W/ ELECTRIC FUEL PUMPS
F = . ‘ A b sun /@ ELECTRIC FUEL PUMPS
GREUND G-801 AIR CONDITIONER AND/BR WEATER PG.2-F4  —357 BK 3 o—57 BK —b—57 Bk —0
57 BK 6-701 6-702 =
14406
FUEL
1 I 2 I 3 I 4 I 5 ] 6 I 7 i 8 [ 9 | 10 I 11 [ 12 [ 13 | 14 I 13 L 16 SUAGE » Cro-286 0
€-20% t-221 C-626 €-207 €-505 €-510 c-512 SENDER 57 8K
JUNCTION BLBCK * 108987 14401 3
JUNCTI@N BLBCK = 7 W 108942 TP OF FUEL TANK
eN 852 BL -—IT0){0} ©13-852 BL 14401 108942 BL @1 16 R-GR
- . TRIC FUEL PUMP @NLY
(198573) BK —{T0){04(CT3359 BK-W (1348851 851 GR Or— (OT=+ 851 GR 655 R-0 BK 896 8K bty Y ONIT e (H-60 BK-4 » ELECTRIC FUE
848 R-N ot (CT3-848 R-H WHIT -
94261 OF 143051596 8K ~CTO101(OT-338 B 194342 lo Ba% Y-8 BEHIND 1/1 Ea H. SIDE @F CLUSTER|| IGNITION _ii’f’“ (B350 Bx-er c-703
33 R-H Pomene ] -
(94281 @R 143051 597 R ——TO)$01(CT—397 R (3a342} (143051 31 W-R £I0)10t @I 31 W-R (14401) 19 BL-R ® 0IL PRESSURE WARNING LAMP SWITCH 597 Bx-6R BEHIND CLUSTER FUEL 94350
(14305133 R-u o 39 R-W (14401) JUNCTIGN BLOCK — ) PUNP ® 57 8K
(3A281 @R 14305)787 R-BR ——T[0)101(CT1—787 R-BR (9A342) — 31 W-R 599 R-BL
(104998 B8R 14305)45 Y-R 1ot G345 v-R 5 30 BK-GR == HeTeR
(14572) 482 BL-Y —m@?.o.@:—4ez BL-Y (14401} (10A998 BR 14305)17 W—CT0)——0O 17 W 286 0 14305 o8 BEHIND I/P, L.H. SIDE ¢-513 ON FUEL TANK
482 BL-v “‘3©13 R-BK ol @13 R-8K (14401 870 8K-W {=L0)1O(CT3-870 BK-H (14401 o 50 GR-W - 10398
- —(:I:)< ' - ——O— 4 R (14401)
(14290) 284 R- ‘O o= 2? R (14401 o 57 BK PRESSURE » OF-17 C-511 108942 704
12 GR-BK —CT0){01(CT—12 6R-BK (144011 810 R-8k —TO)1OH(CTF-810 R-BK (14401) ° 34 GR-BK SWITCH §0 BK-u FUEL 94342
o 60 BK-HW
(142901 11 BK-Y ——T0)101(CT3—11 BK-Y (14401} 3 6R-4 CTO)1OHCI-3 GR-H (1089391 BK -C©\0/@D—888 BL (14A313) 43 W-BL L.H. REAR BF ENGINE 14401 TEMPERATURE PUNP 599 R-BL
nr N - o= ) (14674)1% 143 R 0 (OT3-143 R "(14665) NATURAL IGNITIBN - o o5 oy GAUGE OF39 R-w MANUAL @ 596 BK
FOR_CONTINUATION SEE C-205A 2 4-8L—CTQ—10 2 uoBL (14674) "% 142 GR —:@—0/@3:—142 GR "™ (14668) SHITCH TR 598 R-BR
IN ENGINE COMPARTMENT. @N DASH PANEL, R.H. SIDE BEHIND INSTRUMENT CLUSTER c-507 GEHING 1/P. L.H. SIDE BEHIND TEMPERATURE GAUGE CONTRAL
IN ENGINE C@MPARTMENT, @N L.H, SIDE @F DASH (14674) 141 BK TTOFO1-(CT-141 BK (14665 @R 14668 . 100897 » LoH, SWITCH
45 Y-R BEHIND I/P, RIGHT @F CLUSTER
(-624 (9A350) 675 GR-R ——LOHO(CTF 675 GR-R (9A342) BL _@@:74 GR
UNCTI@N BLOCK (9A350 ) %% §74 BR-W ——TO)—| (CT3-674 BR-W **% (3A342) c-305
C-205A y — Ot Bk <@ @f 838 BK GROUND CBDES C-705
o (9A350) "%=® 787 R-gR -—TOY| [NCT 787 R-BRY™%¥ (34342) 896 BK
JUNCTION BLOCK 42) "% 797 R_gr —TOY 4 6-502 IN 108942, ATTACHED T@ L.H. SIDE OF CLUSTER 8350
NN (144341) 284 R CTO)7Or (OT-870 BK-W (14401) 1983421 70 Jol G- 673 6k (5342 14305" BEWIND 1/P CLUSTER. L.H. SIDE )| ¢ 50y IN 94350, ATTACHED T0 FRAME SIDE MEMBER FUEL  @T3-673 GR
~ 14401 i dal i (3A350) 673 GR i { R9E306" * WATER TEMPERATURE WARNING LAMP || ¢.702 IN 90350, ATTACHED T@ FRAME SIDE MEMBER GAUGE ®
(14405) 283 ¥-BK o} 283 Y¥-BK (14401) 1501 672 8 / \@]:}672 BR (98342 SENDER 57 BK
- 404 - (94 ) 2 BR -
eseg ) 304 GRE 'g:@) °© @:’—gg‘aﬁ‘fyk (144051 282 6R TO)H0O{- ©T+282 &R (14401 ) sen @169 R-GR —— 37 8K us
( ~—Jo! (178719207 8K ~—TO) BEHIND PASSENGER SEAT, @UTBBARD SIDE = CUMMINS DIESEL 14305 oR SPLICE CODES TOP 8F FUEL TANK (L.H,)
14305) 37 BK-Y 654 Y-BK 7~ Ot (CT3-207 BK (14401) L ELECTRIC FUEL PUMP ONLY
(143981 655 R-8—T0){01(ET3—655 R-8 (1483411 207 8K ] ® 2 SPEED AXLE, ELECTRIC SHIFT MIDDLE L.H. SIDE 8F ENGINE NATER 104398 TN 19901, NEAR 1AKEQUT 10 STEERING CoLomm "
) . (9A342 @R 14406) 286 8 -CT10)~Or(CT=286 @ (14401) s 2 SPEED AXLE, AIR SHIFT o 1430598 TEMPERATURE & (OT71-45 v-R §-303 ’
(96724 @R 14398) 32 R-BL —T0){01(CT-32 R-8L 114405) 285 B8R >o—@:3—2ss BR (14401) wus DUAL TANK W/EL. PUMP SWITCH C-706
(9E306 BR 14305) 69 R-GR ol @I -69 r-6r 114A341) 285 BR -CT0) gk <@ ©r69 R-GR 34350
(12336) 853 R-GR —C@-—:}— [ (14405) 283 Y-8k -CLO)HOF(CT3-283 v-BK (14401) wmss SINGLE TANK W/EL. PUMP ve Care DIESEL FRONT CENTER @F ENGINE FUEL crs or-R
(14305) 16 R-GR —CL0){01(CTT—16 R-GR (144051 282 6R —TD)~O} (CT3-262 GR (14401) TOP L.H. SIDE @F ENGINE ELECTRICAL SYSTEMS 1976 L-SER (CITY DEL) GUAGE ® S
(143981 262 BR —c::@j— 5ol Gx o €-3509 CHARGE , START, RUN SENDER 57 8K
FOR CONTINUATION SEE C-205 (144057 140 BK-R 1°r 140 BKCR (78379 R 13523 wes FUEL TANK SELECTOR 14401 10337 EFFECTIVE P.C.R. 57 Bk ms
IN ENGINE canpf::rnsng oN D:SH PANEL » L.H. SIDE (78379 BR 133251140 BK-R e 140 8K-R (144010 YALYE BN SOLENAID 77 P Q) @7 a8 AL {LECTRIC FUEL PU (PR';N"
v LK. =10 @ -30- T P 6H-900-6 ELECTRIC FUEL PUMP 8NLY
' BEHIND PASSENGER SEAT BEHIND I/P, L.H. SIDE DATE 10730773 TRPSERVICE AND TRAINING WAN PAGE E——| N
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1 | 2 | 3 | 4 1 S | 3 ] ? ] 8 | 9 | 10 | 11 | 12 | 13 | 14 | 13 | 16
C-802
. 150404
CONNECTOR C-606  POWER DSTR,- P@,1-E12 y——763 8-
IGNITIBN SWITCH  CHGE,START,RUN- PG.6-B4  S—599 R-BL ‘ 137 v-8k @ ©-137 v-BK
AB@VE W/S. NEAR CENTER
a | FUEL PUNP SWITCH  CHGE ,START.RUN- PG,6-B15 9——599 R-BL 399 FUSE F-8  POWER DSTR.- PG.1-F12 y——137 v-#Kk = A a RADIO
CONNECT@R C-205 & C-205A CHGE ,START ,RUN- &_@j'ﬂ
PG.4-C4 BR PG.5-D4 S—32 R-BL
C-803
c-3521 . 1]
CONNECTBR C-521  PBWER DSTR.- PG.1-All Y41 BK-Y *3‘ ,ﬁﬂ 8K E@an
po— - L - -
K
CONNECTOR C-606 POWER DSTR,- PG.1-E12 941 BK-Y o l 1 BX 8
BK-Y ABOVE W/S, NEAR CENTER
IGNITION SWITCH  CHGE ,START,RUN-  PG,6-B4 ¥—877 P-N —— 1 c-615 ;da v RADIO SPEAKER
' ' ' n R
B SPLICE §-502  POWER DSTR,- PG.1-Di1 $—~977 P-W —=— LON ]‘ 1 l 8 v RADIO
vatuun
614 /S/W WASHER SWITCH
SPLICE S$-502 POWER DSTR,- PG.1-D1l &—~43 8-BL WARNING 3 3 32 c-6l T zuspsggug DEPRESSED PARK
’] INDICATOR R-8L  R-BL R-BL R-BL
SHITCH i —ﬁ
] C-61% g o0 DI 4 —
l I €-620
. ‘ 32 R-BL ——
¢ ¢-320 R-W c-619 4 L ez N R c
977 A PN, VAR VA
PeW ( c-621 0 6 63
C-501 2 D::L C-619 T C-649 c-621 oR )
T ot useo BRAKE 977 Tc-ns i i
— HARNING P-W 42 74 | GR RagL
BRAKE | ot c-526 INDICATOR A i 2
LOW AIR g1p LOMP Low
BUZZER | l WARNING TIIAN c-622
0 c-520 INDICATOR - C-529 TERMINATES 9 6-602 0
c-501 v 927 P LANP IN-LINE Y IN HARNESS
- -H 57 -t 3y R-BL
?
N 44 l B DIBDE R | oote 65 GR
977
_ P-N 377 /L START/ RECEIVER -
? I N -N - AL
A c-524 M c-616 T €-529 o q i";‘,‘ﬁ“’”
74 °© f'p»? Q%2 | Lamp surtcH 48 | 61| 58
IN-LINE ;s BKL Yoy He
£ DI80E (A -2y c-503 o) FOR ADDITIONAL START/INTERLOCK R BL £
/l\ €-503 4 B/U LAMP SWITCH CIRCUITRY SEE L i ju.
41 PG.9- -8 - - -
N c-524 917 977 BK-Y 6.9-C11 KT €-803 C-617 TTT £ C-618
977 PN — 44 P-W o & ok
886 8L —O-—[O]- W/S/HW
43 9-BL 977 i BK S i_J l
] ° PoW ) N C-626 BK 2 SPEED —
—43 0-BL A A 28 Z €-525 ’ £-525 BK gapte | FAT- DEPRESSED
¢-502 AIR SYSTENS RECEIVER PARK
c-527 - DUAL 57 ONLY SPEAKER MOTOR
BRAKE oL B BL rRansnIssIoN c-628 N
¢ LOW AIR LN AIR WARNING oG TEMPERATURE oIL i F
PRESSURE PRESSURE S“ITC“ 1 “ARNING TEHPERQTURE
SWITCH SHITCH _ SKITCH 4 TNDICATOR TENPERS
= - - = R = - BK LAMP SWITCH
HYDRAULIC @NLY aIR oveR Wyoraurc ©008 6-803
1 ] 2 | 3 I 4 | 5 I 6 ] 7 8 I 3 1 10 [ 11 T 12 T 13 I 14 [ 15 [ 16
t-521 [C-626 C-503 C-524 C-528 C-616 108920 C-621 C-628
. 7B379
JUNCTI@N BLOCK 28325 14401 buAL 28325 57 8k 57 8K 12 2-5L-@ oIL 108939
[O] 977 P-W 977 P-H BRAKE 977 P-W 42 R-W 42 R-W 14401 TEMPERATURE 8«
377 P-W 977 P-# WARNING 977 P-H s ©-32 R-BL WARNING
© 977 P-W SHITCH BEHIND I/P, L.H. SIDE 14A31 SHITCH
DIGDE = 74 6R
© 14401 28325 2ase BEWIND I/P, L.H. ® LBH VACUUM HARNINE LANP 5@ ON SIDE OF TRANSHISSION HOUSING
° 77 7P @77 pou CENTER OF CLUSTER Te1s BEHIND CENTER OF I/P
(108333) 8K -CION| | (CT-886 BL (14a313) e g:@ @2;7 P » LEFT HAND SIDE OF 178587
(14674)% 143 R -<E@\ /(@D-ua R"(14665) INSTRUMENT PANEL T-529 65 GR c-622 ¢-801
ua - 1
(146741 %% 142 &R -CTOTOF-(OT-142 GR "™ (14668 2£203 Len313 WuSI:IEERLD . - . 28379 15h404 Le401
(14674) 141 8K -CTO1O-(CT-141 BK (14665 BR 14668 @:g;; i: YL ©-74 &R HBTOR 48 BK 32 R-BL 32 R-BL g: gigt
. . DIODE = 32 R-BL 32 R-BL . -
§9 R-GR —TO) 138350) 675 GR-R —CIO-O[-(CI3-675 GR-R (38342) 140313 100924 @4 ok L.H. SIDE 8F ENGINE COMPARTMENT 1640 BX-R 140 BK-R e 207 BK
(90350 %%% §74 BR-N L0t —(CT 674 BR-H "**% (3A342) BEHIND I1/P, CENTER BF CLUSTER 207 8 207 BK
140A997 1 896 BK —EZ@ 114401) (94350 ) "s88 787 R-BR -@, \@D_?B? R-BRUSEE (91347) 87846 GBR oL LEFT HAND SIDE ©F C-618 140 BK-R 140 BK-R 137 Y-BK 137 y-8K
- L .
(148313141 BK-Y IO @E:(zg‘kfzﬂnuuou (9a342) "9%% 787 R-8R —CTOY A e ot BXox g:ak INSTRUMENT PANEL 178587 BEWIND R, SIOE OF 1/P BEWIND I1/P» L.H. SIDE
i PART @F START/NEUTRAL SWITCH
(10B846 ) 41 BK-Y 142 GR (14668) (9A350) 673 GR &\@:"973 GR (93A342) o + RANSHISSION TEMPERATURE — N/SHIELD 28 K-0 . oF S
8 R-BR 598 R-BR (9A342) _4—_—()/ \@—_—,. - WIPER  ® 1y
‘1“01’535 R.“):@ @:(5:7 ) 9{9“3942, 19A350) 672 BR o 672 BR (3A342) DuAL 1977 P-N WARNING INDICAT@R LAMP 178587 MOTeR 56 8L SROUND CODES
(903421599 R-BL TIO) 32 R-BL (14401 BEHIND PASSENGER SEAT, QUTBBARD SIDE ng:';is . -@@- 56 BL
599 R-BL (14401} = 2 SPEED AXLE, ELECTRIC SHIFT o457 BK 57 BK L.H. SIDE @F ENGINE C@MPARTMENT || &-503 IN 38325
(1348831 §9 R-GR sm 2 SPEED AXLE. AIR SHIFT SWITCH ¢-526 8 W-0 §-602 IN 178587, ATTACHED T8 L.H. SIDE C@ML
JUNCTI®N BLBCK BEWIND I/P. L.H. 14401 63 R C-619 6-603 IN 104920, ATTACHED T@ L.H. SIDE COWL
BEWIND I/P, NEAR CENTER mes DUAL TANK W/EL. PUMP CENTER OF CLUSTER W/SHIELD oy 78379
sass SINGLE TANK H/EL. PUMP 977 P-u 8] = WIPER  ® 65 GR 32 8L 1,40
. NOT USED SWITCH 57 BK SPLICE CODES
C-520 763 8-W 14a313 @32 R-BL
¢-301 t-302 14401 . BEHIND I/P, L.H. SIDE 74 GR
14404 c-527 74 GR
BRAKE 2146
LaW AIR (043 @-BL - “-zéetg:‘z:”. o5 0-5L 977 P-H 977 P-W L.H. LaW AIR 2K146 C-613 BEWIND CENLTER @F I/P
PRESSURE ®  2K146 SHITCH 43 8-BL 977 P-H 977 P-W PRESSURE = [O}-43 0-BL 104920 ELECTRICAL SYSTEMS 1976 L-SER (CITY DEL)
HARNING 43 0-BL 977 P-4 GRAY SHITCH LB VACUUM [}-42 R-W C-620 CHARGE , START, RUN
BUZZER 977 P-M LOWER R.H, SIDE @F DASH, WARNING = E 14401 14401 EFFECTIVE P.C.R. RADIO
BEHIND I/P. NEAR CLUSTER AT TBE BBARD BEH&%LCE{;?:LEER;a:i‘}’:«scim? LOHER §}"%9213§a23 pas swiren e 32 R-8L @ @32 R-BL SUPERSEDES WINDSHIELD WIPER/WASHER
' M. ATE 10-30-75 TRP@ ELECT INST MAN PAGE EGH-900-7
L.H. SIDE 8F ENGINE COMPARTMENT BEHIND CENTER OF I/P DATE 1 O LT INST KON e e ot
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Il | 2 | 3 | 4 | 5 | 6 | ? | 8 | 9 | 10 | 11 | 12 | 13 14 | 15 | 16

SPLICE $-803 EXT.LIGHTING- PG,9-E4 S————810 R-BK T
FUSE F-4 POWER DSTR.- PG.1-(12 Smm—————383 R-W e 383 R-N e &= 383 R-H = . 14401
c-907 282 6R 282 &R
o |CIRC.BREAKER CB-2 POWER DSTR.- PG.1-B13 S=—————200 BL A 3 GR-H 3 6R-K
; , 283 v-BK 283 v-8«
SPLICE §-503 P@WER DSTR.- PG.1-Bl1l =25 BK-0 _ rQ\:\o a4 8L 44 BL
TURN a ! 810 2 W-BL 2 W-8L
CIRC.BREAKER [B-1 P@WER DSTR.- PG.1-B13 =684 BK-H 1 SIGNAL ; R-BK 482 BL-Y 482 BL-Y
— - 284 R 810 R-8K
T C-1040 §-902 FLASHER r 460 Y ——460 v
5 )
BK: 0 Q\Q 8N STEERING COLUMN
f E::';i“ AR % ¢-907 » STEERING COLUMN WIRING
- s TRACTOR TRAILER T/S SWITCH
8 o [surtew 2o R SN ] - 8
“““““ c-501 C-903
Y C-1010 e A \ 14401
C-901 ' 77T T C-901 777777 0N T c-901 54 GR-Y
$-1003 284 44 284 44 284 R 201 BL-Y
— I 207 BK Ny 207 BK Tzo? BK TURN aND LB y LB il LB —_l — 201 BL-Y
HEADLAMP EMERGENCY 25 BK-8
A0 c-801 207 SWITCH SWITCH SIGNAL o TURN HEADLAMP 285 8R
B X0 |emeraency AND SHITCH © 285 BR
‘ SIGNAL @—0 | |EMERGENCY 15 R-¥
c 207 207 FBR ADDITIBNAL H/D LP.SK. 15 SIGNAL c 19 BL-R
BK 207 BX CIRCUITRY SEE? ? e o (SS/ITBC:ME T“——-OO SHITCH —"" 53 gK-BL
€-1015 [§] OR P@WER DSTR.- PG.1-C9 F $ , Q¥ |everr1nE )
[ ‘ | 283 282 3 - 26%2 3 ;. T 3 C-904
- T T C-1014 207 207 207 207 207 ® -205 & v-gK &8 LG-N 283 ; LEH T Les 6K Le-K — 14401
K K 2
Bj B)t A B)t A C-2054 WL Y-BK | W-LB l v-8k | Wlis DIMMER [i” R-8K
c-1011 C-1011 . 15 R-Y
0 T T 0 0 230.(7 —0————‘11 BK-Y 285 BR €-901 | v C-901¢. ¥ V. J, ______ Vo) C-901 SHITCH 12 GR-8K
207 207 207 207 207
I 012 812 BK BK BK BK BK & 904 §-303 Y-- Y-S 0 ON HEADLAMP DIMMER SWITCH
m BL ROOF \ 285 BR ————O-— @—0—7 283 282 $-905 —
MARKER C-820 c-624 285 Y'g“ Gg 3 LG-W 3 LG-H —Q og 13076
LANPS HEADLAMNP Q R ' 13105
s? 57 s 57 57 DINMER P——13 R-BK 285 Lo 2 W-LB 2 W-8L ——o-—fg] c-221 @] c-221
B . e B)t th ai a)t Bi By suncu €905 B c-625 c-62¢ [9] [O] c-62e 282 263 ' ; B HEADLANPS ® :; ga;gx
He MIRROR BN 13 R-BK ———— O — [B] ~ O R Y-BK -
@nmaan @,mm c-1011 c-1011 v 13 RoBK 13 RoBK e @ b G¢ b ? ? 57 8K
MARKER T T T T T €-205 & -820 —0 | 2 3
™ Law : tz:goa ey s s s o c- 904T--T 2l (2050 12 GR-BK —————c»—@—o—————-——] Y\ [ 285 Yz_sesx 2@8522 HggL @ @ sggu W-18 LG-H AT R.H. BR L.H, HEADLANP
K BK K - BR
£ G CanapR BNLY o Bl o 2 er Q L 13 R-8K —0 e P L S 6 C-624 1 I c-626 £ s
$-1005 o-B-© 12 GR-8k —O-—[0} - 13 R-BK - 285 289 C-625 [§) [] C-625 & op0r 282 283 , [@] c-905 [@] c-905 s a4 BL
a 57304 C-205 & ~ A i L 6R  v-BK Y ¢-207 ' FLASHER " 383 R-W
2! 2 6R-BK c- 2058 C-906 c-906 —t—o ¢ 43 ggp eon-s 50 Q
] BX BX L.H. R.H. 283 282 W-BL Yooooe GR-H ] ) — 8N INSTRUMENT PANEL
50 27 Le BEAN Lo BEAM Y-BK 6R | H-BL GR-W
Bk BK 207 207 282 283
BK BK Y ©-207 HEAD HEAD A C-1010
| o s GR  Y-BK R.H. L.H. 14401
: - c-821 - T/8 T/8 MARKER
2 2 Xel c-821 LoH. Rt 6R B centl Ny N/ NN N Lanp Lanp LANP 684 BK-H
F 6-1002 6-1006 = FRANT FRENT HI BEAM c-908 ¥ c-906 o v R.H. TURN L___V___J L.H. TURN F Su1TCH 207 8K
6-1003 To SIDE @ @ SIDE INDICATOR 5% 57 1o ' - INDICATER  1g INDICATER 57 57 TeR
TRAILER  MARKER ® MARKER & Lanp BK BK TRAILER  L.H., ST@P R.H, STaP LANP TRAILER LANP BK BK R.H. SIDE @F 1/P CLUSTE
CONNECTOR C-826 PRBTECT.8 CBNV.- PG.10- F15 $——57 BK —— WIRING LAMP - T LANP - O——57 BK —Q _é 6-902 ‘é’G-SOI WIRING PARK & T/S PARK & T1/S WIRING Q ¢ 1005 é‘s-moa
" §-903 " -904 ; § LANP LANP : - C-1011 _ e0e
1 [ 2 T 3 I ] T 5 I 3 [ 7 I 8 [ 9 I 10 I 11 I 12 I 13 | 14 | 15 | 16 207 8K 207 BK
€-205 c-221 C-625 C-1015 57 3K 57 BK
JUNCTIBN BLBCK JUNCTION BLACK JUNCTION BLOCK 14405 o 178720 ABAVE WINDSHIELD (5 PLACES)
(o} MIRROR RBF MARKER LANP
] 852 BL LTO){O} (O 1-852 8L (13405) 283 v-8k —TO){O}(OT-283 v-8BK MarkER " A_157 BK * Roe
(198573) 8Kk ——T0)1OH(CT3—359 BK-H (194885 ) 851 GR—CI0)—O 851 GR 5?7 8K
848 R-W -CL0)40t(OT 848 R-H (134041 282 GR -CT0)-Of (CT3-282 6R LanP C-1013
(94281 BR 143051596 BK —T0)101(CT—596 BK (3A342) o (134051 285 B8R ~CT0) o7 L.H. MIRROR MARKER LANP 178719 14401
o (CT3-285 BR H.
(34281 @R 143051 597 R —CTO)101(CT—597 R (3a342) (14305) 31 W-R CTO){Or (CT3-31 W-R (14401) 113404 285 8R 1O) 207 8@ ©-207 B«
(14305) 33 R-W—CT0)—O— 39 R-W (14401) (13405) 140 BK-R -CLO)-{O (CT+140 BK-R C-1017 UNDER I/P. NEAR L.H. SIDE COML
(9A281 B8R 14305) 787 R-BR ——L0)101(CT—787 R-BR (3A342)
(104998 @R 14305) 45 Y-R 10+ (@TF-45 Y-R (13404) 140 8K-R -CT0) R.H. 178720
(14672482 BL-Y —‘3@7—0-@1:3—492 BL-Y (14401) (10A998 BR 14305)17 W—TO)—1O 17 W MIRRBR | =y o, gy C-1014
482 BL-Y —CT0) - . 870 BK-K -LI0){OF (GT1-870 BK-M (14401) R.H. REAR FRAME SIDERAIL-INSIDE 7 8K MARKER 178720 178719
(14290 2> RBK CIO1o@13-13 R-BK (14401) 284 R—CT0)—O 284 R (14401} LANP SRoUND CODES 812 8L @ ©-207 B«
12 6R-BK —CTO)101(CT 12 6R-BK (14401} 810 R-BK —CT0){O+(CT-810 R-BK (14401) C-820 AT R.H, HIRRBR MARKER LAMP ¥ 13070 AT1ACRED To Rom. maad INNER PANEL UNDER I/P, NEAR R.H. SIDE COWL
-y ——T0)t0t (O - o 15436 14341 6-901 N . H H.
(14230) 11 BK-¥ s 11 BK-v (14401) 3 GR-W LTO){0+(O I3 6R-W 282 &R 282 G C-207 a1 §-902 IN 13105, ATTACHED T@ R.H. HBBD INNER PANEL TG
FOR CONTINUATION SEE C-205 2 -BL—T0O)—O; 2 W-8L 212 BL 0 285 BR 14401 108942 6-903 IN 14290, ATTACHED T8 R.H. HABD INNER PANEL 178720 178719
IN ENGINE C@MPARTMENT, @N DASH PANEL, R.H. SIDE 285 BR 212 BL 655 R-@ 655 R-@ 6-904 IN 14230, ATTACHED T@ L.H. SIDE OF DASH PANEL
IN ENGINE COMPARTMENT, ON L.H. SIDE BF DASH 206 W e e® 654 Y-BK 654 ¥-BK 6-1002 IN 178720, ATTACHED T@ L.H. COWL SIDE 812 8L @ |OF 207 8k
T 207 8K 284 ® 39 R-M 39 R-M 6-1003 IN 15A404. ATTACHED T8 L.H. COWL SIDE
283 Y-BK —207 BK 19 BL-R 19 BL-R 6-1004 IN 13201, ATTACHED T@ R.H. HBBD INNER PANEL
¢-2054 JUNCTION BLOCK 284 R g 263 Y-BK 31 W-R 31 u-R §-1005 IN 13200, ATTACHED T@ R.H. HBBD INNER PANEL UNDER I/P NERR L.H. SIDE COML
© 30 BK-6R 30 BK-GR 6-1006 IN 178720, ATTACHED T@ R.H. COWL SIDE
BEHIND CAB. LOWER L.H., SIDE
JUNCTIBN BLOCK
(14a341) 284 R CTO)10{(OT3-870 BK-H (14401) 286 @ 286 @ 15436
N GR- ; . SPLICE CBDES
14401 (14405) 4 50 L} 50 GR-H 283 v-BK
(14398) 504 GR-R ——T0)101(CT3—904 GR-R 14405) 283 v-BK LTQ)O1-(OT-283 Y-8 (14401) c-905 57 Bk 57 BK 212 BL $-902 IN 14401, NEAR TAKEBUT T@ HEATER SWITCH
(14398) 37 BK-Y —T0) 37 BK-y (144051 282 6R —T0)-O} (OT3-282 GR (14401) JUNCTI@N BLBCK 34 GR-BK 34 GR-BK IRAILER 207 BK -903 IN 14401, NEAR TAKEBUT T@ BRAKE WARNING LAMP
(14305) 37 BK-Y 9=T°] §54 Y-BK (178719)207 BK “:‘i@> - 49 W-8L 43 u-8L PLUG " 206 W 5-904 IN 14401, NEAR TAKEQUT T@ F@AT DIMMER SWITCH
- of (OT—+207 BK (14401) (142901 2 w-8L IO O} ({CT-2 w-8BL (13200} LUG
(14398) 655 R-8—T0)101(C T 655 R-8 (148341) 207 BK LTO) 207 BK (33201 ) NATURAL 285 BR 5-905 IN 14401, NEAR TAKEBUT T@ T/S SWITCH
(9A342 @R 14406) 286 8 -CLO)-Of- (CT3-286 8 (14401) (14290) 11 BK-y —T0) O 207 Bk 113200) BEWIND INSTRUMENT CLUSTER 282 GR $-906 IN 14401, NEAR TAKEQUT T@ T/S SWITCH
(9€724 BR 14398) 32 R-BL —CT0){0+(CT3—32 R-BL (144051 285 BR ":@>o~@t}2es BR (14401 o (Ormmg 1 284 R $-1003 IN 14401, NEAR TAKEBUT T@ HEATER SHITCH
(9E306 @R 143051 69 R-GR ‘a@}_.o.,@[j_sg R-GR (14a341) 285 BR —LO) 801 BEHIND CAB $-1004 IN 150404, NEAR TAKEBUT T@ RADIG
(12336) 853 R-6R (14405) 283 Y-BK —LO)HO-(CT3-283 Y-BK (14401) (14290112 6R-BK -CTO)HOk @z::l—zz GR-BK (13076 150404 14401 $-1005 IN 15R404, NEAR TAKEQUT T@ RADIO
(14305) 16 R-6R ——T0)101(CT 316 R-6R 12 GR-BK (13105) )
(14398) 262 BR IO (144051 282 6R —LO)~OF(CT3-282 6R (14401) (14290) 13 R-BK -C@~O (G- 13 R-8K 113076 2 ELECTRICAL SYSTENS 1976 L-SER (CITY DEL)
(14405 140 BK-R -CT0)1O+(CT3-140 BK-R (78379 @K 15525) (14290) 3 GR-W —4:©~0 (G313 R-8BK (13105) 53 BK-BL 207 BK EXTERI@R LIGHTING
FBR CONTINUATI@N SEE C-205 T 207 BK EFFECTIVE P.C.R.
(78379 BR 155251140 BK-R -CLO)O} (CT3-140 BK-R (14401) (Cr-3 6R-W (13201} . 207 BK
IN ENGINE COMPARTMENT, @N DASH PANEL, L.H. SIDE — 137 ¥-BK 137 v-BK 52:2“95052 s 'RP@ ELECT INST MAN PAGE EGH-300-8
BEHIND PASSENGER SEAT IN ENGINE C@MPARTMENT, GN H@BD INNER PANEL ., R.H. SIDE BEHIND I/P» L.H. SIDE OATE 1 SERVICE AND TRAINING MAN PAGE
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4 | 2 I 3 l 4 l 5 | § | ? | 8 9 | 10 | 11 | 12 l 13 | 14 | 15 | 16
FUSE F-6 PBNWER DSTR.- PG.1-F12 140 BK-R 140 BK-R
CIRC.BREAKER (B-4 PBWER DSTR.- PG.1-C13 =578 Y
5-802
FUSE F-3 POKER DSTR.- PG.1-F12 Y284 R o—T—“zu R —O- - Q)]
|
TURN & EMERG. SIGNAL SWITCH- 264 b c-221
EXTERIOR LIGHTING- PG.8-C12 S— H rﬁ IRAILER PACKAGE
T 5-804 / Ae0
284 R
810 )
R-BK T c-816 284 578
R 284 284
284 R R hf Q
R J:———zu R Lé)]
l C-818 g——284 R —————O C-818 c-819 &) c-819 Ac---- C-418 '
Tc‘eu i . i P T ----- T b c-824
L——sTepLane @ ——sTepLanp Q——sTopLANP Q——sToPLANP ét S e ams 204
SKITCH SHITCH SKITCH SWITCM LB PRESSURE (L/o—J BRAKE R ( )
b HYDRAULIC | AIR b AIR b TRACTOR QPERATING ) : aNTI 140 BK-R 1
BRAKES G BRAKES | BRAKES o TRAILER SHITCH : SK1D I‘ s
[}
c-817 c-818 G—810 R-BK ——b C-818 c-819 v C-415 RELAY 1 c-622 BK-R
(TRAILER )
c-819 870 é 140
\ NeT g BK-W = B R c-623
USED 810 i BK-M START/ T
gro PNITH 810 R-BK $ --------- INTERLOCK ST |sackup
R-BK :;gﬂs | | 00 60 PFPP %ogi s B/U {—«\ LaNP
LAMP SWITCH SHITCH
810 R-BK @] c-221 [®] c-624 1 i
[ S-805 ' ' BiK‘~0R C-623
o | b——870 BK-# —O 1 T
N C-816 Q c-221 0 c-622 160
1 140 BK-R Bk R
@] FBR CUST@MER USE 1 J)
i - AS NEEDED —— O—212 BL ( )
o} c-825 FOR ADDITIBNAL START/INTERLOCK
L0 & B/U LAMP SWITCH CIRCUITRY SEE C-624
PG.7-E7 |
TERMINAL GRBUNDED 284 ]
810 INTERNALLY T@ R |
R-BK BBDY ©F CONNECTOR l ?
...... AN V.
® Y-y ez ol
206 284 J)
5-803 " . C-825
810 R-BK 212 i
QJL\ 140 BK-R —O-—[B]--0—140 BK-R
SN LM, R.H.
c-821 BACKUP BACKUP
np AnP
19 s L
TRAILER - i
WIRING
1 I 2 I 3 ] 4 T 5 I 6 I 7 ] 8 9 I 10 I 11 I 12 I 13 [ 14 I 15 i 16
c-221 -625 £-817 c-821
JUNCTION BLBCK JUNCTIBN BLBCK 14405 13436
BN 134612 283 ¥-BK
852 BL —TL0){O} (CT3-852 BL (13405) 283 v-Bk —T0)-{O} (OCT3-283 v-BK S TopLanp 51— 810 R-BK 217 BL
851 GR o} 851 GR « @O 207 BX
848 R-W —T0){0+(CT3-848 R-W 113404 ) 262 GR LTO)0r (CT-262 &R SWITCH of—284 R TRAILER
pY (134051 285 B8R ~— ol G285 8% PLUG gog :R
(13404) 285 BR -LTIO) @N BRAKE PEDAL SUPPERT 8
(14305) 31 W-R CT0)10+(CT3-31 W-R (14401} ) ) 282 GR
(14305) 39 R-W—T0)——1Ot— 39 R-W (14401) (13405) 140 BK-R -C1O)O1-CT-140 BK-R 284 &
(10A398 @R 14305145 Y-R —T0){Or(CT 45 v-R (13404) 140 BK-R -CTO) c-818 a8
1100998 8R 14205) 17 4—LTQ)——OF —(OT 317 R.H., REAR FRAME SIDERAIL-INSIDE 130612 pENIND €
870 BK-W L T.0){O1(CT 870 BK-W (14401) He
284 R—_T0)—O 284 R (14401) Crox 810 R-8K C-825 .
0 R-B ©r=-s10 ® 4401) C-820 148271
810 R-BK —TO) 8 810 R-BK (14401 15436 148341 810 R-BK . @212 8
282 6R
3 GR-4 LTO)1OH(OT -3 GR-4 212 BL — g 265 bR stepLanp @ BEWIND PASSENGER SEAT
2 W-BL—CTO)—tor—(CT=—2 u-8L 285 BR 212 B ST Broc284 v » FOR CUSTEMER USE
IN ENGINE COMPARTMENT, @N DASH PANEL . R.H. SIDE 206 W 0 @B®)) | 04 ¢ 284 R
207 BK @I:J
C-624 283 V-BK o —207 Bk
JUNCTION BLOCK 284 R 283 Y-8k IN ENGINE COMPARTMENT, SROUND CODES
— i Y
BEHIND CAB. LOWER L.H. SIDE L.H. SIDE OF DASH PANE:
(14A341) 284 R -CLO)HO1(OT-870 BK-K (14401) —— =53 ===
(14405) 283 v-BK -CTO)+O}-(CT3-283 v-BK (14401) 14401 15525 130411
(14405) 282 GR —TO)HO+(CT 282 GR (14401} TRAILER 870 BK-W BACKUP 140 BK-R @810 R-8X
(1787191207 BK S0} (G207 8K (14401) STeP LAMP w § D578 ¥ LANP W 140 BK-R SPLICE C@DES
(14A341) 207 BK -CLO) RELAY 284 R SHITCH 810 R-Bx
(9A342 @R 14406) 286 @ -E@*O»@D—ZBG 8 (14401) 8N TOP @F TRANS HOUSING @I:J—' 8-202 i: :::gio :E:: ;::E:g; I: :;::t::: ::i;g:
(14405) 285 BR -—T0) . 5-803 .
(148341) 265 BR -CTO) 10| CT285 BR (14401) c-822 . 28379 SIOPLAT s 1284 R 5-804 IN 130411, NEAR TAKEGUT T@ EMERG. TRR. ST/LP SW.
(14405) 283 Y-BK -CLO)O+(CT 283 Y-BK (14401) N 12 Rt C-816 SHITCH 284 R $-805 IN 13A411, NEAR TAKEBUT T@ JUNCTION BLECK
(14405) 282 GR O)+or-(@13-282 6R (14401) 32 R-BL 32 R-BL 13R612 14401 ELECTRICAL SYSTEMS 1976 L-SER (CITY DEL)
XTERIGR LIGHTIN
(14405) 140 BK-R -—TO)O (CT-140 BK-R (78379 8R 15525) 1:8 gﬁ': ;:g g:': 810 R-BK g%:sm R-BK ©13-870 BK-4 CEFECTIVE PaC.® EXTERIOR LIGHTING
- - 4R 4R TR,
(78379 2R 155251140 BK-R -CLO)-tor (CT-140 BK-R (14401) BEHIND R.H. SIDE OF I/F 28 28 IN ENGINE COMPARTMENT, SUPERSEDES
He NEAR BRAKE PEDAL SUPPBRT ATE 10-30-7 TRP@ ELECT INST MAN PAGE E6H-900-9
BEWIND PASSENGER SEAT ® PART BF START/NEUTRAL SWITCH L.H. SIDE @F DASH PANEL DATE 10-30-73 SERVICE AND TRAINING NAN PRGE 3|

bRl S
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N C-309

FUSE F-5

PBWER DSTR.,- PG.1-C12

1 l 2 | 3 l 4 | s l § l ? | 8 9 | 10 11 | 12 13 L 14 | 15 | 16
CIRC.BREAKER CB-2  POWER DSTR.- PG.1-B13 =460 ¥
1 c-o
(—.__.A~____\ $-901
1 T FUSE F-5  P@WER DSTR,- PG,1-C12 9=—=354 GR-Y —§——54 GR-Y
460
i‘ CIRC.BREAKER CB-2  P@WER DSTR,- PG.1-813 ¢——200 BL
C-908
SPLICE §-503  P@WER DSTR,- PG&,1-Bii 425 BK-0

e 4 () BL-W ==

T A" TANA T“T"‘T C-309 J\
480 AB L ¢-903 P c-1012
| ‘é COURTESY
> HBRN sf?u HEADLANP Q ::??CH
p| | |SHITCH A SWITCH T
| 8K BKBK
oA T’c-1012
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INTRODUCTION

The Why and Wherefore of Wiring Diagrams

To the uninformed, a wiring diagram — or a wiring assembly —
looks like it might take a genius to figure out.

Not so — as you'll find out when you get better acquainted with
these subjects.

There're as understandable and logical as a road map and road
markers, when you're finding your way on a cross -country drive.

The ability to read a wiring diagram and relate it to a vehicle's
wiring system is, of course, an essential part of a modern service tech-
nician's skill. And it's growing in relative importance, too, due to
owner's increasing demands for the comforts and conveniences supplied
by electrically - operated options and accessories. This opens up greater
opportunities, for the forward -looking technician.

The Purpose of this Booklet . . .

. is to acquaint you with the systems by which electrical circuits are
traced on vehicles. Specifically, it is designed to help you acquire the
ability to make your own power checks, quickly and accurately.

Scope of the Booklet

Basically, this is a printed version of the film, "How to Read a
Wiring Diagram.” It is in no sense a manual of the shop methods by
which electrical repairs are made.

It can be a helpful guide that can introduce you to the principles of
wiring diagrams and vehicle wiring. As you gain experience in reading
wiring diagrams, you'll accumulate your own know-how in this impor-
tant skill. When it becomes "second nature" to you, these pages will
have served their purpose — and yours.
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To show how to read wiring diagrams — and
to explain how they can be used to help you
troubleshoot problems in the electrical system —
is what this booklet is all about. Obviously, these
are important subjects.

When you go to a doctor, for example, he tries
to find out what's really wrong with you. He looks
beyond the aches and pains you feel, to see what's
causing the trouble. We call this, diagnosis.

If a customer comes in because his headlights
aren't working, you can't just make a snap deci-
sion. That's not the professional way.

Troubleshooting an electrical system calls for -
diagnosis, too — Your diagnosis. You're the
doctor. You must find out what's causing the
trouble, and fix it.



https://ford-shop-manuals.com/D21760

